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ACRONIS, INC.
End User License Agreement (EULA)

BEFORE INSTALLING AND USING THE SOFTWARE PRODUCT WHICH EITHER YOU HAVE
DOWNLOADED OR IS CONTAINED ON THESE DISKS (*SOFTWARE”) YOU SHOULD CAREFULLY
READ THE FOLLOWING LICENSE AGREEMENT (* AGREEMENT”) THAT APPLIES TO THE
SOFTWARE. CLICK “ACCEPT” IF YOU FULLY ACCEPT AND AGREE TO ALL OF THE PROVISIONS
OF THIS AGREEMENT. OTHERWISE, CLICK “DO NOT ACCEPT.” CLICKING “ACCEPT” OR
OTHERWISE DOWNLOADING, INSTALLING AND OR USING THE SOFTWARE ESTABLISHES A
BINDING AGREEMENT BETWEEN YOU AS THE PERSON LICENSING THE SOFTWARE (THE
"LICENSEE") AND ACRONIS, INC. LOCATED AT: ACRONIS INTERNATIONAL GMBH
VERWALTUNG EURO HAUS RHEINWEG 5 SCHAFFHAUSEN, SWITZERLAND CH-8200,
("LICENSOR"). IF YOU DO NOT ACCEPT ALL OF THE TERMS OF THIS AGREEMENT, YOU SHALL
HAVE NOT RIGHT TO DOWNLOAD, INSTALL AND/OR USE THE SOFTWARE AND MUST DELETE
THE SOFTWARE AND ASSOCIATED FILES IMMEDIATELY.

This Agreement applies to the Software, whether licensed under a Software License and/or an
Evaluation License, each as defined and described below:

Purchased License of Software. Subject to the terms and conditions of this Agreement, upon
purchase of a license to the Software, LICENSOR grants and LICENSEE accepts a nonexclusive,
nontransferable, nonassignable license to use Software only for LICENSEE’s own internal use solely on the
specific number of Hardware (as defined below) licensed owned, leased or otherwise controlled by LICENSEE.
LICENSEE may make one copy of Software only for archival purposes, only in machine readable form, provided
that such archival copy is only used for archival purposes and never in a production environment and is marked
with every notice on the original Installation of Software is LICENSEE's responsibility. The license described in
this section shall be referred to as a “Software License”).

Evaluation License of Software: The LICENSEE has the right to evaluate the Software for a period
of time not to exceed fifteen (15) days (the “Evaluation Period’) unless extended by LICENSOR. Software
licensed under this Evaluation License may not be used in a production environment. There will be no charge to
the LICENSEE for said evaluation of the Software under this Evaluation License. At the conclusion of the
Evaluation Period, unless a Software License to the Software is purchased, the LICENSEE will delete the
Software from its systems and have no further license or other rights with respect to the Software except as to
the rights and responsibilities in this Agreement. LICENSOR SHALL NOT BE LIABLE FOR ANY SPECIAL,
DIRECT, INDIRECT, PUNITIVE, OR CONSEQUENTIAL DAMAGES RESULTING FROM USE OF SOFTWARE
UNDER THE EVALUATION LICENSE UNDER ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY OR
OTHER THEORY. THESE LIMITATIONS SHALL APPLY NOTWITHSTANDING ANY FAILURE OF ESSENTIAL
PURPOSE OF ANY LIMITED REMEDY. The following sections of this Agreement also apply to Evaluation
License(s) of the Software: Limitations, Confidentiality, Disclaimer of Warranties, LICENSEE Indemnity,
Law, Export Restrictions, and Miscellaneous. The license described in this section shall be referred to as an
“Evaluation License”).

Use Rights:

Assigning the License. Before you run any instance of the Software under a Software License, you must
assign that license to one of your PCs or Servers (depending upon the license you have purchased or are
evaluating and such purchase or evaluation is based upon the operating system on which that hardware
operates, such PCs or Servers shall be referred to as the “Hardware”). That Hardware is the licensed
Hardware for that particular Software license. You may assign other Software Licenses to the same Hardware,
but you may not assign the same Software License to more than one Hardware except as identified herein.

You may reassign a Software License if you retire the licensed Hardware due to permanent Hardware failure. If
you reassign a Software License, the Hardware to which you reassign the license becomes the new licensed
Hardware for that particular Software License.

Running Instances of the Hardware Software. You have the rights to run the Software on one piece of
Hardware as defined above. Every Hardware creating an image and every Hardware to which an image is either
deployed to or restored from must have a valid license. In the case of Universal Deploy or Universal Restore,
every time an image is deployed or restored (as appropriate to either Universal Restore or Universal Deploy), to
Hardware that is dissimilar to the Hardware from which the image was originally created, a valid license of the
Universal Deploy or Universal Restore is required.

You have the rights below for each Software License you assign:



Standard Software license. A standard Software License is the general license that is available to
LICENSEE. Unless the Virtual Edition Software is purchased, you have purchased the standard Software
License and may run on the licensed Hardware, at any one time as follows:

e One (1) instance of the Hardware installed Software in one physical operating system environment; and

e Up to four (4) instances of the Hardware installed Software in virtual operating system environments
(only one (1) instance per virtual operating system environment).

If you run all five (5) permitted instances at the same time, the instance of the Hardware installed Software
running in the physical operating system environment may be used only to run hardware virtualization
software and to manage and service operating system environments on the licensed Hardware.

Virtual Edition. Virtual Edition (as identified by the product name (for example, True Image Virtual Edition)) is
licensed by physical Hardware. You may run on the licensed Hardware, at any one time as follows:

e One instance of the Hardware software in one physical operating system environment; and

e As many instances of the Hardware software in virtual operating system environments.

Support. If LICENSEE is under a current support contract with LICENSOR with respect to the Software and is
current in paying all amounts due thereunder, LICENSOR shall make available to LICENSEE the support
described in this paragraph (the “Support”) on a twenty four (24) hours a day, seven (7) days per week basis.
Support shall consist of: (i) supplying telephone or other electronic support, as determined by LICENSOR in its
sole discretion, to LICENSEE in order to help LICENSEE locate and, on its own, correct problems with the
Software and (ii) supplying all extensions, enhancements and other changes that LICENSOR, at its sole
discretion, makes or adds to the Software and which LICENSOR makes generally available, without additional
charge, to other licensees of the Software that are enrolled in Support. Upon mutual written agreement by both
parties, LICENSOR may, but shall not be required to: (i) supply code corrections to LICENSEE to correct
Software malfunctions in order to bring such Software into substantial conformity with the published operating
specifications for the most current version of the Software unless LICENSEE’s unauthorized modifications
prohibit or hamper such corrections or cause the malfunction; or (ii) supply code corrections to correct
insubstantial problems at the next general release of the Software.

Limitations. Notwithstanding any references to “purchase” , the Software is licensed and not sold pursuant to
this Agreement. This Agreement confers a limited license to the Software and does not constitute a transfer of
title to or sale of all or a portion of the Software, and LICENSOR retains ownership of all copies of the Software.
LICENSEE acknowledges that the Software contain trade secrets of LICENSOR, its suppliers or licensors,
including but not limited to the specific internal design and structure of individual programs and associated
interface information. Accordingly, except as otherwise expressly provided under this Agreement, LICENSEE
shall have no right, and LICENSEE specifically agrees not to: (i) transfer, assign or sublicense its license rights
to any other person or entity, or use the Software on ay equipment other than the Hardware, and LICENSEE
acknowledges that any attempted transfer, assignment, sublicense or use shall be void; (i) make error
corrections to or otherwise modify or adapt the Software or create derivative works based upon the Software, or
permit third parties to do the same; (iii) reverse engineer or decompile, decrypt, disassemble or otherwise reduce
the Software to human-readable form, except to the extent otherwise expressly permitted under applicable law
notwithstanding this restriction; (iv) use or permit the Software to be used to perform services for third parties,
whether on a service bureau or time sharing basis or otherwise, without the express written authorization of
LICENSEE; or (v) disclose, provide, or otherwise make available trade secrets contained within the Software in
any form to any third party without the prior written consent of LICENSOR.

Confidentiality. The Software is a trade secret of LICENSOR and is proprietary to LICENSOR. LICENSEE
shall maintain Software in confidence and prevent disclosure of Software using at least the same degree of care
it uses for its own similar proprietary information, but in no event less than a reasonable degree of care.
LICENSEE shall not disclose Software or any part thereof to anyone for any purpose, other than to employees
for the purpose of exercising the rights expressly granted under this Agreement. License shall not, and shall not
allow any third party to, decompile, disassemble or otherwise, reverse engineer or attempt to reconstruct or
discover any source code or underlying ideas, algorithms, file formats or programming or interoperability
interfaces of Software or of any files contained or generated using Software by any means whatsoever. The
obligations under this paragraph shall survive any termination of the Agreement.

Disclaimer of Warranties. THE SOFTWARE IS PROVIDED “AS IS” AND LICENSOR DISCLAIMS ALL
WARRANTIES, EXPRESSED OR IMPLIED WITH RESPECT TO SOFTWARE INCLUDING ALL IMPLIED
WARRANTIES OF MERCHANTABILITY, TITLE, NON-INFRINGEMENT OF THIRD PARTIES’' RIGHTS, AND
FITNESS FOR A PARTICULAR USE. WITHOUT LIMITING THE FOREGOING, LICENSOR DOES NOT
WARRANT THAT THE FUNCTIONS CONTAINED IN SOFTWARE WILL OPERATE IN THE COMBINATION
LICENSEE SELECTS, THAT OPERATION OF SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE
AND/OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. THE ENTIRE RISK AS TO THE




RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY LICENSEE. FURTHERMORE,
LICENSOR DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE
RESULTS OF THE USE OF THE SOFTWARE OR RELATED DOCUMENTATION IN TERMS OF THEIR
CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. NO ORAL OR WRITTEN
INFORMATION OR ADVICE GIVEN BY LICENSOR SHALL CREATE A WARRANTY OR IN ANY WAY
INCREASE THE SCOPE OF THIS WARRANTY.

Liability Limitations. LICENSOR SHALL NOT BE LIABLE FOR ANY SPECIAL, INDIRECT, PUNITIVE, OR
CONSEQUENTIAL DAMAGES RESULTING FROM USE OF SOFTWARE UNDER ANY CONTRACT,
NEGLIGENCE, STRICT LIABILITY OR OTHER THEORY. LICENSOR'S CUMULATIVE LIABILITY FOR
DAMAGES HEREUNDER, WHETHER IN AN ACTION IN CONTRACT, WARRANTY, TORT, NEGLIGENCE,
STRICT LIABILITY, INDEMNITY, OR OTHERWISE, SHALL IN NO EVENT EXCEED THE AMOUNT OF
LICENSE FEES PAID BY THE LICENSEE FOR THE SOFTWARE LICENSED UNDER THIS AGREEMENT.
THESE LIMITATIONS SHALL APPLY NOTWITHSTANDING ANY FAILURE OF ESSENTIAL PURPOSE OF
ANY LIMITED REMEDY.

LICENSEE Indemnity. LICENSEE agrees to indemnify and defend LICENSOR, and hold it harmless from all
costs, including attorney’s fees, arising from any claim that may be made against LICENSOR by any third party
as a direct or indirect result of any use by LICENSEE of the Software,

Termination. This Agreement and the license may be terminated without fee reduction (i) by LICENSEE
without cause on thirty (30) days notice; (ii) by LICENSOR, in addition to other remedies, if LICENSEE is in
default and fails to cure within ten (10) days following notice; (iii) on notice by either party hereto if the other party
ceases to do business in the normal course, becomes insolvent, or becomes subject to any bankruptcy,
insolvency, or equivalent proceedings. Upon termination for any reason, LICENSEE shall immediately return
Software and all copies to LICENSOR and delete all Software and all copies from the Hardware.

Law. This Agreement shall be governed by the laws of the Commonwealth of Massachusetts, exclusive of its
conflicts of laws provisions and without regard to the United Nations Convention on Contracts for the
International Sale of Goods, and any suit under this Agreement shall exclusively be brought in a federal or state
court in Massachusetts. Any action against LICENSOR under this Agreement must be commenced within one
year after such cause of action accrues.

Government End Users. This provision applies to all Software acquired directly or indirectly by or on behalf of
the United States Government. The Software is a commercial product, licensed on the open market at market
prices, and was developed entirely at private expense and without the use of any U.S. Government funds. If the
Software is supplied to the Department of Defense, the U.S. Government acquires only the license rights
customarily provided to the public and specified in this Agreement. If the Software is supplied to any unit or
agency of the U.S. Government other than the Department of Defense, the license to the U.S. Government is
granted only with restricted rights. Use, duplication, or disclosure by the U.S. Government is subject to the
restrictions set forth in subparagraph (c) of the Commercial Computer Software Restricted Rights clause of FAR
52.227-19.

Export Restriction. LICENSEE will not remove or export from the United States or the country originally
shipped to by LICENSOR (or re-export from anywhere) any part of the Software or any direct product thereof
except in compliance with applicable export laws and regulations, including without limitation, those of the U.S.
Department of Commerce.

Miscellaneous. This Agreement contains the entire understanding of the parties and supersedes all other
agreements, oral or written, including purchase orders submitted by LICENSEE, with respect to the subject
matter covered in this Agreement The delay or failure of either party to exercise any right provided in the
Agreement shall not be deemed a waiver. All notices must be in writing and shall be delivered by hand (effective
when received) or mailed by registered or certified mail (effective on the third day following the date of mailing).
The notices addressed to LICENSOR shall be sent to its address set out above. If any provision is held invalid,
all others shall remain in force. LICENSEE may not assign, pledge, or otherwise transfer this agreement, nor any
rights or obligations hereunder in whole or in part to any entity. Paragraph headings are for convenience and
shall have no effect on interpretation. In the event that it is necessary to undertake legal action to collect any
amounts payable or to protect or to defend against the unauthorized use, disclosure, distribution, of the Software
hereunder and/or other violation of this Agreement, LICENSOR shall be entitled to recover its costs and

expenses including, without limitation, reasonable attorneys' fees.
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Chapter 1. Introducing Acronis®
Recovery for MS Exchange

This chapter provides general information about a new Acronis product - Acronis
Recovery for MS Exchange - its features and advantages. You will learn about
supported databases, operating systems and platforms.

1.1 What is Acronis Recovery for MS Exchange?

Acronis Recovery for MS Exchange offers a fast and reliable disaster recovery solution
to protect your Microsoft Exchange data. It features a proven database backup
technology that will drastically reduce disaster recovery time: you can be up and
running again in minutes instead of hours. It also provides document level backup,
providing incredible flexibility that allows backing up of only individual mailboxes/public
folders and uses message filters to reduce both an archive size and duration of a
backup process.

Acronis Recovery for MS Exchange is shipped in two editions — original Acronis
Recovery for MS Exchange for larger organizations and Acronis Recovery for MS
Exchange Small Business Edition (Acronis Recovery for MS Exchange SBE) for small
and/or start-up businesses. See 1.3 “Difference Between Acronis Recovery for MS
Exchange Editions” for more information.

One-step Recovery and Automated Recovery to a Point-of-Failure reduce downtime
and helps improve your organization’s Recovery Time Objective (RTO).

Acronis Recovery for MS Exchange is an excellent complement to the award-winning
Acronis True Image suite of disaster recovery and system migration products that use
patented disk-imaging technology. Together they deliver comprehensive server system
backup and restore and also full Microsoft Exchange database protection — a winning
disaster recovery plan combination.

¢ Ultimate Granularity

Acronis Recovery for MS Exchange provides the ultimate in granularity for
backup and restore. Backup and restore operation can be applied to a
whole information store, individual storage groups, mailboxes/public
folders or even single emails.
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With Acronis Recovery for MS Exchange you can restore your crucial
mailboxes or single emails from different kinds of backup — not only from
brick-level backups, but from a whole-database backup archive as well.

Smaller, more manageable archives

Award-winning Acronis technology provides superior image file optimization.
Customizable compression rates reduce the amount of data to store and
transfer, leading to direct cost savings in storage and labor.

High Speed

Acronis Recovery for MS Exchange provides proven database backup
technology that maximizes backup speed.

With its ability to restore any data (mailboxes, public folders or individual
emails) from a database level backup, Acronis eliminates the need for time-
consuming brick-level backups.

Active Restore™

Active Restore™ mode provides full Microsoft Exchange Server functionality
for users in minutes, while the system is still being restored. Using Active
Restore™, combined with automated Dial-tone restore mode, you can limit
downtime of your Microsoft Exchange 2007 Server to only seconds.

Continuous Data Protection

Continuously back up transactions to enable the complete restoration of
Microsoft Exchange Server databases with minimum data loss.

Faster Disaster Recovery

One-step Recovery and Automated Recovery to the point-of-failure help
organizations meet aggressive Recovery Time Objectives (RTO).

Encryption for Security
Protect companies' most valuable data with industry-standard encryption.
Centralized Management

The Acronis Recovery for MS Exchange Management Console automatically
detects all database servers on the network. The servers are displayed
clearly with status information, making it easy to manage enterprise-wide
installations.

Resource Management

CPU and bandwidth throttling let you allocate resources during the backup
process to ensure users remain productive.

Guided Disaster Recovery

Acronis database backup also provides you with a Disaster Recovery Plan,
detailing step-by-step instructions to guide you or your team through a fast
and complete recovery. Even non-technical staff members can follow these
simple instructions to restore even the most sophisticated Microsoft
Exchange server.

Integration with Acronis True Image Echo

Installed on the same computer, Acronis True Image Echo Update (build
8115 or later) and Acronis Recovery for MS Exchange can restore a whole
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production server (operating system and whole information store) on bare
metal from bootable CD or from a PXE.

o Easy Administration

Intuitive wizard-driven GUI allows even non-DBAs to confidently configure
and implement professional backup strategies.

1.2 Why Acronis Recovery for MS Exchange?

Comprehensive recovery requires more than just a backup of information stores. Your
Microsoft Exchange mailbox server contains storage groups, logs, mailboxes, public
folders, mails, and other components that structure the data. Using Acronis Recovery
for MS Exchange, a cohesive and intuitive backup solution, is the critical step you can
take to ensure a secure live Microsoft Exchange mailbox server backup that can be
quickly recovered.

With Acronis Recovery for MS Exchange restoring individual emails became easier —
you can do it from any kind of backup (both database and brick-level).

Recovery is now made easy with automated system restore to a point-of-failure. There
is no need to walk through menus to get your system back online. This one-step
process will return your database to the last known good state just before failure.
Erroneous transactions will no longer cost you minutes or hours in recovery.

This powerful product includes an intuitive wizard-driven GUI that guides you through
the scheduling process and reduces the possibility of errors. The Backup Strategy
Assistant creates a Disaster Recovery Plan for your environment, delivering step-by-
step instructions for recovery. Anyone, whether an experienced DBA or not, can
schedule backup jobs and handle system restores rapidly. Acronis even provides FTP
capability for storing your backup on any FTP server, worldwide.

1.3 Two Acronis Recovery for MS Exchange Editions

You can choose between two editions of Acronis Recovery for MS Exchange. Your
choice is based on the size environment it will be installed in:

) Acronis Recovery for MS Exchange, appropriate for larger businesses

o Acronis Recovery for MS Exchange Small Business Edition (Acronis
Recovery for MS Exchange SBE). This less expensive alternative is tailored
for small and/or start-up businesses. The agent can only be installed on
Windows SBS 2003 and Windows SBS 2008 operating systems.

1.4 Advantages
With Acronis Recovery for MS Exchange you get the following advantages:
e Hot Backup

Backup can be performed while the Microsoft Exchange service is online
and serving clients allowing 24/7 availability

¢ Restore Emails from Database Level Backup

Acronis Recovery for MS Exchange provides the ability to restore specific
emails from database level backup

¢ Tuning a Backup Strategy with Acronis Recovery for MS Exchange
Assistant

12



1.5

Acronis Recovery for MS Exchange Assistant provides an intuitive GUI for
easy creation and implementation of a backup strategy, even without DBA
experience

Disaster Recovery Plan

Automatically creates and e-mails Disaster Recovery Plans with step-by-step
instructions on recovering databases. The guided process makes it possible
for staff to restore databases quickly, even without DBA skills

Recovery to a Selected Point-in-Time

With transaction log backed up, Acronis Recovery for MS Exchange allows
you to specify a date and time to restore your data from

Key Features

Database Backup (Fastest Method)

Acronis Recovery for MS Exchange provides the ability to backup all data at
a database level. This is the fastest, but the least flexible backup method

Brick-Level Backup

Acronis Recovery for MS Exchange provides the ability to backup all data at
a documents level (brick-level). This is not the fastest, but the most flexible
backup method

Bare Metal Restore

The bare metal restore feature restores a whole production server
(operating system and all databases) on bare metal from a bootable CD or
from a PXE. This feature is available only if Acronis True Image Echo
Update (build 8115 or later) and Acronis Recovery for MS Exchange are
installed on the server

Automated recovery to point-of-failure

Automated recovery to point-of-failure allows easy one-step recovery to a
point just before failure or disaster with no loss of data

Encryption

Protect backups with industry strength-standard encryption technology. AES
(Advanced Encryption Standard) is available with three key lengths — 128,
192 and 256 bits to balance performance and protection as desired

Compression

Create backups up to 10 times smaller than the original uncompressed
format. Three compression levels let you optimize for faster performance,
smaller size, or a balance of both

Dial Tone Recovery

Acronis Recovery for MS Exchange can restore e-mail service more quickly
to users (providing them with a basic "dial tone") and then restore users'
previous data as it becomes available

Bandwidth Throttling

Control bandwidth usage to keep the backup process transparent to
network users
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1.6

¢ Notifications

Configure notification via e-mail and SNMP

¢ Automated recovery staging

Every restore scenario can be executed in one step. There is no need to
manually restore from different archives keeping in mind the database state

e Scheduling complete backup strategy

Schedule the complete backup strategy, including Full and Incremental
backup in one action

e Restore Mailboxes from Brick-Level Backup
The system provides the ability to restore mailboxes from brick-level backup
¢ Restore Mailboxes from Database-Level Backup

The system provides the ability to restore mailboxes from database level
backup

e Restore Emails from Brick-Level Backup

Acronis Recovery for MS Exchange provides the ability to restore specific
mails from brick-level backup

¢ Command-Line Mode

The system provides command-line user interface

Supported Microsoft Exchange versions

e Microsoft Exchange Server 2007 (Standard/Enterprise Editions)
e Microsoft Exchange Server 2003 (Standard/Enterprise Editions)

o Microsoft Exchange Server 2000 Server with post-Service Pack 3 rollup
(Standard/Enterprise Editions)

Important! Acronis Recovery for MS Exchange Agent is only guaranteed
to work with Microsoft Exchange Server 2003 service packs installed. Note, to
handle MAPI interfaces correctly, Service Pack 2 and hotfix kb908072 must be
installed (see Microsoft website for details).

In case you are using Microsoft Exchange Server 2007, make sure Microsoft
Messaging APl and Collaboration Data Objects 1.2.1 are installed (they are
included in Microsoft Exchange Server 2007 product, but will not be installed
by default). Visit Microsoft website:

http://www.microsoft.com/downloads/details.aspx?FamilylD=94274318-27c4-
4d8d-9bc5-3e6484286b1f&DisplayLang=en

Note, this version of the package is now compatible with Windows Vista and
Windows Server 2008.

Please note, Acronis Recovery for MS Exchange is not a cluster-aware product.

1.7 Supported Platforms

e x86 (for Microsoft Exchange Server 2000/2003)
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e Xx86-64

1.8 Supported Operating Systems for Acronis Recovery
for MS Exchange Agent
For Acronis Recovery for MS Exchange:
e Windows 2000 (SP4 Rollup 1)
e Windows Server 2003 (both 32-bit and 64-bit versions)
e Windows 2008 Server
For Acronis Recovery for MS Exchange Small Business Edition:
e Windows SBS 2003
e Windows SBS 2008

1.9 Supported Operating Systems for Acronis Recovery
for MS Exchange Management Console
e Windows XP (SP 1)
e Windows Vista
¢ Windows 2000 (SP4 Rollup 1)
e Windows 2003
¢ Windows 2008

1.10 License Policy

Acronis Recovery for MS Exchange licensing is based on the number of servers on
which Acronis Recovery for MS Exchange Agent is to be installed. You will need a
unique serial number to install every single Acronis Recovery for MS Exchange Agent.

Acronis Recovery for MS Exchange is provided with three types of licenses:

Permanent - allows you to use the fully functional product without any time
limitations (permanent serial number is required)

Trial - allows you to use the fully functional product for 14 days (trial serial number is
required)

Registered — used for customers, registered on the Acronis web site. It also allows
working with the fully functional product for 14 days (no serial number is required)
Obtaining Permanent Serial Numbers

Obtaining a permanent serial number depends on the way you purchase Acronis
Recovery for MS Exchange:

e you will find it in the CD box if you buy the licensed Acronis Recovery for
MS Exchange CD

e you can receive it after registering on the Acronis web site in case you
download the product (also during installation of the product)
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Trial Serial Numbers

Acronis allows you to have a trial serial number to be able to use Acronis Recovery for
MS Exchange for 14 days without buying the product. You may obtain the trial serial
number in one of the following ways:

e in the CD box
e contacting Acronis sales representatives. Visit

http://www.acronis.com/enterprise/products/ARExchange/qgettrial/

You have to sign in (or register) to obtain a trial serial number.

If you downloaded a trial version of Acronis Recovery for MS Exchange from our web
site and want to buy a permanent license to continue using the product, please contact
our sales representatives. In this case you will not have to download the product
again, but only enter a registered serial number during the installation.

Note, the Management Console should be connected to Acronis Recovery for
MS Exchange, otherwise the Registration menu item will not be presented in
the Help menu.

The number of Acronis Recovery for MS Exchange Management Console installations is
not limited.

1.11 Technical Support

As part of a purchased annual Support charge you are entitled to Technical Support as
follows: to the extent that electronic services are available, you may electronically
access at no additional charge, Support services for the Software, which Acronis shall
endeavor to make available twenty four (24) hours a day, seven (7) days per week.
Such electronic services may include, but are not limited to: user forums; software-
specific information; hints and tips; bug fix retrieval via the internet; software
maintenance and demonstration code retrieval via a WAN-accessible FTP server; and
access to a problem resolution database via Acronis customer support system.

Support shall consist of supplying telephone or other electronic support to you in order
to help you locate and, on its own, correct problems with the Software and supplying
patches, updates and other changes that Acronis, at its sole discretion, makes or adds
to the Software and which Acronis makes generally available, without additional
charge, to other licensees of the Software that are enrolled in Support. Upon mutual
agreement by both parties, Acronis shall: (i) supply code corrections to you to correct
Software malfunctions in order to bring such Software into substantial conformity with
the published operating specifications for the most current version of the Software
unless your unauthorized modifications prohibit or hamper such corrections or cause
the malfunction; or (ii) supply code corrections to correct insubstantial problems at the
next general release of the Software.

More information about contacting Acronis Technical Support is available at the
following link: http://www.acronis.com/enterprise/support/
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Chapter 2. Understanding Acronis
Recovery for MS Exchange

This chapter provides common information about working with Acronis Recovery for
MS Exchange.

2.1 Components
Acronis Recovery for MS Exchange includes the following components:

e Management Tools including Acronis Recovery for MS Exchange
Management Console

e Acronis Recovery for MS Exchange Agent

2.1.1  Acronis Recovery for MS Exchange Management
Console

Acronis Recovery for MS Exchange Management Console is a tool for managing data

backup/restore on the local network from a single location. Using it, you can install

agents remotely, schedule tasks, recover data remotely, and set backup/restore
options on remote Exchange servers.

2.1.2 Acronis Recovery for MS Exchange Agent

The Acronis Recovery for MS Exchange Agent is installed on the computers on which
you want to backup/restore a Microsoft Exchange database.

2.2 Components Integration

Acronis Recovery for MS Exchange Management Console is installed on the computer
from which you plan to manage operation processes on remote database servers.

After issuing a backup or restore command from the Management Console, Acronis
Recovery for MS Exchange sends a request to the Acronis Recovery for MS Exchange
Agent to retrieve the required storage group or mailbox from Microsoft Exchange and
sends it to Acronis Recovery for MS Exchange, which backs up the selected data.

Below are diagrams describing interaction between Management Console and Agent.
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Integration between Acronis Recovery for MS Exchange and Acronis Recovery for MS
Exchange Agents

2.3 Integration with Acronis True Image Echo Enterprise
Server

Acronis Recovery products are integrated with Acronis True Image Echo Enterprise
Server Update (build 8115 or later) that provides the ability to automatically execute
preconfigured restore tasks in case of disaster.

There are three points of integration:

e Ability to start Acronis Recovery for MS Exchange tasks from the Acronis True
Image Echo Enterprise Server management console

e Bare metal restore

e Microsoft Exchange Server files exclusion while creating backup tasks with
Acronis True Image Echo Enterprise Server

2.3.1 Starting Tasks from the Acronis True Image Echo
Enterprise Server Management Console

Integration allows accessing main Acronis Recovery for MS Exchange functions

(wizards and tools) from the Acronis True Image Echo Enterprise Server management

console in case if both consoles are installed on the same computer. The Acronis
Recovery for MS Exchange Agent must be installed on the remote computer.

Clicking the corresponding button, user will launch the desired Acronis Recovery for MS
Exchange wizard or tool directly. This functionality will be disabled if any of Acronis
Recovery for MS Exchange Agent or Management Console is not installed.

2.3.2 Bare Metal Restore

Acronis Recovery for MS Exchange provides the ability to restore a whole production
server on bare metal from a bootable CD or from the PXE. This functionality is provided
by Acronis True Image Echo Enterprise Server.
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Configuring Bare Metal Restore

To restore all necessary information stores on bare metal or to create a bootable
media, you need a previously created archive with required information stores backed

up.
After creating an archive, do the following:

1. Launch a Restore wizard to schedule a restore task and choose a Bare Metal
Restore option in the first step.

2. Specify a task execution account.

3. Choose an archive and point in time (point of failure), select the necessary storage
groups and set additional parameters (such as a password) for each archive.

4. Backup a partition with Acronis Recovery for MS Exchange installed using Acronis
True Image Echo Enterprise Server (see Acronis True Image Echo Enterprise Server
User’s Guide for detailed information).

Restoring a Server from a Bootable Media

After hardware failure it is necessary to restore the whole system, including the
operating system and databases, located on different hard drives. To restore partitions
and storage groups/databases (to the last possible state), do the following:

1. Start the computer from a bootable media, previously created using Acronis True
Image Echo Enterprise Server.

2. Execute an Echo bare metal restore (see Acronis True Image Echo Enterprise Server
User’s Guide for detailed information).

In case a company stores databases on external SAN/NAS, and an administrator only
needs to restore an operating system, the following actions should be performed: start
the computer from a bootable media, previously created using Acronis True Image
Echo Enterprise Server, and then execute an Echo bare metal restore (see Acronis True
Image Echo Enterprise Server User's Guide for detailed information).

If databases are stored on SAN/NAS, while preparing for restoring, do not configure
bare metal restore tasks, as described in section “Configuring Bare Metal Restore”.

Starting a Bare Metal Restore Task

In case of hardware failure you have to restore the lost partition using the Acronis True
Image Echo Enterprise Server, and then start the Acronis Recovery for MS Exchange
bare metal restore task. To start this task automatically, you need to select the Run
Acronis Recovery for MS Exchange Bare Metal Restore after data recovery
option in the final step of the Acronis True Image Echo Enterprise Server Restore
Data wizard.

2.3.3 Files Exclusion

Integration allows users to exclude Microsoft Exchange Server files while backing up a
partition with Acronis True Image Echo Enterprise Server.

To exclude Microsoft Exchange Server files (*.edb, *.stm, *./og, *.paf), in Acronis True
Image Echo Enterprise Server Create Backup wizard at Source Files Exclusion step
select the Exclude all MS Exchange databases files option.
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Chapter 3. Installation of Acronis
Recovery for MS Exchange

From this chapter you will learn how to install Acronis Recovery for MS Exchange
components both locally and remotely.

3.1 Minimum System Requirements

Acronis Recovery for MS Exchange requires the following hardware:
e Pentium processor or higher
e 1024 MB RAM

e Mouse (recommended)
3.2 Security Policy
3.2.1 Credentials

Acronis Recovery for MS Exchange obtains access to networked computers using two
types of credentials.

1. Credentials with Guest Rights — used for access to configuration and status
data on each computer. The credentials you provide during Acronis Recovery for
MS Exchange installation will be applied to all networked computers. This is
convenient for domain administrators, who can create a domain user account with
guest rights and remote access rights to every computer. In a workgroup, it would
also make sense to create identical accounts with guest rights on each computer
accessed by Acronis Recovery for MS Exchange.

If you do not wish to create a uniform account, you will need to provide guest
credentials for each computer after the installation and initial network discovery via
Manage Computer -> Set Credentials.

You can combine both methods. For example, set a uniform account for domain
members and set individual accounts for members of a workgroup.

2. Administrator Credentials — used for performing migration, deployment or other
tasks which require such rights. These are entered during creation of tasks.
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Naturally, you are free to use administrator credentials for both purposes. This will
work, but make sure it conforms to the security policy set in your network.

3.2.2 Firewall Settings
Acronis Recovery for MS Exchange uses the following ports for remote operation:

e server (Acronis Recovery for MS Exchange Agents) UDP port: 9876

e server (Acronis Recovery for MS Exchange Agents) TCP port: 9876, if busy
choose a port at random

e client (Acronis Recovery for MS Exchange) UDP port: 9877, if busy
choose a port at random

You might have to set the appropriate firewall access options. Options for the Windows
Firewall, included in Windows XP Service Pack 2, Windows 2003 Server and later
Windows versions, are set automatically during installation of Acronis Recovery for MS
Exchange components. However, make sure that the option File and Printer
Sharing in the Control panel -> Windows Firewall -> Exceptions is enabled on
the remote computer, before the remote operation starts.

3.3 General Rules of Installation

Acronis Recovery for MS Exchange components and their features can be installed in
multiple configurations, in terms of distributing the components and features among
the networked computers.

3.3.1 Installing Acronis Recovery for MS Exchange
Components

There are two ways to install Acronis Recovery for MS Exchange components — local
and remote.

To install Acronis Recovery for MS Exchange Management Console and Acronis
Recovery for MS Exchange Agent locally:

e run the Acronis Recovery for MS Exchange setup file

e in the Install Menu, select the program to install: Acronis Recovery for MS
Exchange Management Tools or Acronis Recovery for MS Exchange Agent

e follow the install wizard instructions on the screen

It is recommended that you install Acronis Recovery for MS Exchange Management
Console first. This will allow you to install Acronis Recovery for MS Exchange Agent
remotely from the Management Console to any networked computer (for information
about the remote installation see 3.3.2 “Installing Acronis Recovery for MS Exchange
Agent remotely”).

In addition, Acronis Recovery for MS Exchange supports the Microsoft Installer utility
(msiexec.exe) and its commands, so that you can install Acronis Recovery for MS
Exchange components from a command line. MSI installation command and options
are listed in Appendix B.
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3.3.2 Installing Acronis Recovery for MS Exchange Agent
Remotely

To install Acronis Recovery for MS Exchange Agent remotely on a database server, you

first need Acronis Recovery for MS Exchange Management Console installed on the

local computer. The remote system must meet the requirements described in 3.1
“Minimum System Requirements”.

Before remotely installing Acronis Recovery for MS Exchange Agent on
Windows 2008 Server, open port 25001 for TCP protocols for an inbound
connection.

Run Acronis Recovery for MS Exchange and click Install Acronis Recovery for MS
Exchange Agent in the Pick a Tool pane.

1. Specify the location of installation files of the Acronis Component you want to
install.

e Select from the registered components (by default)
e Search removable media for the required installation files

e Search for the installer in the specified location (you will have to specify the
location by clicking Browse...)

Click Next to continue.

2. Select the program you want to install on the remote computer from the list
(Acronis Recovery for MS Exchange Agent) and click Next.

3. Enter a serial number for the selected product. For information about obtaining
a serial number, see section 1.8 “License Policy”. The Next button will not be
active until you enter a serial number.

4. Select the computer in the Computer field: enter a computer name manually
or click Browse... and select the required computer from the tree. Enter a
User name and password into the corresponding fields to access the selected
computer. By selecting the Save password check-box you can save the
password for future connections.

5. The summary page displays all operations, which will be performed. Click
Proceed to install Acronis Recovery for MS Exchange Agent on the remote
computer.

By connecting to a remote computer with Acronis Recovery for MS Exchange Agent
installed, you can set up backup and recovery tasks, and browse logs.
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3.3.3 Extracting Acronis Recovery for MS Exchange
Components

To install Acronis Recovery for MS Exchange from the command line, you need to
extract the .msi file prior to starting the installation process. Here are the steps for
extracting the file:

e run the Acronis Recovery for MS Exchange setup file;
e in the Install Menu, right-click on the component name and select Extract;

e select a location for the setup file and click Save.

3.3.4 Removing Acronis Recovery for MS Exchange
Components

You can remove any Acronis Recovery for MS Exchange component separately by
selecting Control panel -=> Add or Remove Programs -> <component name=> -
> Remove.

Component names are: Acronis Recovery for MS Exchange and Acronis Recovery for
MS Exchange Agent.

Follow instructions on the screen. You may need to reboot your computer to complete
the uninstallation.
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Chapter 4. Getting started with
Acronis Recovery for MS Exchange

This chapter will help you to start working with Acronis Recovery for MS Exchange, and
will guide you through connecting to a remote server, and remote installation of
Acronis Recovery for MS Exchange Agent.

4.1 Running Acronis Recovery for MS Exchange
Management Console
To run Acronis Recovery for MS Exchange Management Console, select Start ->

Programs -> Acronis Recovery for MS Exchange Management Console ->
Acronis Recovery for MS Exchange Management Console.

Important! Before starting managing the servers’ list (discovering, adding or
deleting servers), modifying the storage groups list for the Disaster Recovery
Plan (see Chapter 6), or changing default options (while creating backup or
restore tasks), make sure the required users have read/write permissions for
the following files, located in Documents and Settings\All Users\Application
DatalAcronis. DatabaseServersExtensions\serverslist.dat for Acronis Recovery
for MS Exchange Management Console, DisasterRecoveryPlans\dbaselist.dat
and RecoveryMSExchangeAgent\settings.cfg for Acronis Recovery for MS
Exchange Agent.

Note, in case Acronis Recovery for MS Exchange Agent is installed on
Microsoft Windows 2000, BackupUser/BackupGroup must be a member of
Domain Admins group. To configure these settings, go to Control Panel >
Administrative Tools. Then sequentially add the BackupUser/BackupGroup in
each of the following security policies: Domain Controller Security Settings,
Domain Secirity Settings and Local Security Settings (Local Policies > User
Rights Assignment 2 Act as a part of the operating system).

Please be aware: Acronis Recovery for MS Exchange will not operate if there is no free
space on the system partition, and the software does not send notices when there is
no free space.
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4.2 Acronis Recovery for MS Exchange Workspace

Acronis Recovery for MS Exchange workspace includes the Acronis Recovery for MS
Exchange Management Console window - the primary tool for managing data
backup/restore on local and remote computers where Acronis Recovery for MS
Exchange Agent is installed.

The workspace consists of the main area with operation icons, as well as the menu,
the toolbar, and the common tasks bar. On the left there is a sidebar featuring the
Computers or Help panels.

Note, that the content shown in the main window will change depending on
whether Acronis Recovery for MS Exchange Management Console is
disconnected or connected to a remote server.

4.2.1 Main Area

The main area of Acronis Recovery for MS Exchange workspace contains Task and
Tools groups.

Before you connect to an Exchange server where Acronis Recovery for MS Exchange
Agent is installed, operation icons will appear in the main program window that will
allow you to navigate and manage computers.

The Pick a Task group contains one operation:

e Connect to a Remote Computer — connect to a remote server where
Acronis Recovery for MS Exchange Agent is already installed

If you select a server in the Computers pane, on which Acronis Recovery for MS
Exchange Agent is not installed, Acronis Recovery for MS Exchange workspace will
display two operation icons in the Pick a Tool group:

e Add Servers — add a Microsoft Exchange server to the group

e Install Acronis Agents — install Acronis Agents on remote computers

As soon as you are connected to a Microsoft Exchange server where Acronis Recovery
for MS Exchange Agent is installed, your workspace will show operations you can
execute on this server, such as backup or restore, managing tasks, etc.

In this case the main area contains operation icons divided into two groups.
The Pick a Task group contains the following operations:
¢ Back Up Information Store — create storage groups backup archive
e Back Up Mailboxes — create mailboxes and public folders backup archive

¢ Restore Information Store — restore storage groups from a previously
created archive

o Restore Mailboxes - restore mailboxes and public folders from a
previously created archive

¢ Backup Location Clean-up - clean database backup locations
The Pick a Tool group contains the following items:
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o Restore E-mails — restore separate e-mails from a previously created
archive

¢ Manage Tasks — manage tasks scheduled on a computer
e Logs — open the Log Viewer window

o Disaster Recovery Plan — generate step-by-step instructions on how to
restore your databases in case of any kind of failure

4.2.2 Computers Pane

The Computers pane is located on the left side of the main program window. It
displays computers (with their Microsoft Exchange servers identified) which have been
discovered by the system or added manually.

Acronis Recovery for MS Exchange Management Console allows you to connect to a
remote computer where Acronis Recovery for MS Exchange Agent is already installed,
or to install Acronis Recovery for MS Exchange Agent remotely.

At the top of the Computers pane there is a toolbar with the following buttons:

e Add server - opens the Add Server window, where you can specify a
server to be added to the tree

e Discover servers - automatically finds servers on the network and adds
them to the tree

e Delete server - removes the selected server from the tree

4.2.3 Program Menu

The program menu bar features the Tasks, Tools, View and Help items.

The Operations menu contains five available operations:

Backup Information Store - create storage groups backup archive

Back Up Mailboxes — create mailboxes and public folders backup archive

Restore Information Store - restore storage groups from a previously
created archive

e Restore Mailboxes — restore mailboxes and public folders from a
previously created archive

Backup Location Clean-up - clean database backup locations
The Tools menu contains five available operations:
o Restore E-mails — restore separate e-mails from a previously created
archive
e Manage Tasks — manage tasks scheduled on a computer
e Logs — open the Log Viewer window

o Disaster Recovery Plan — generate step-by-step instructions on how to
restore your databases in case of any kind of failure
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e Options — open a window for editing default backup/restore options,
setting text appearance (fonts), configuring notifications etc

The View menu contains an item for managing the appearance of the program
window:

e Status Bar — enables/disables the status bar

Acronis Recovery for MS Exchange allows using shortcut keys to navigate
through the program menu. To do this, hold down <A/t>and press the access
key (the underlined letter) of the required menu item. A selected item
becomes active, and still holding down <A/t>, press the access key of the
required command from the submenu.

4.2.4 Help Menu

The Help menu is used to invoke help and obtain information about Acronis Recovery
for MS Exchange.

To view the Help panel, disable the Computers Tree option in the View menu.

4.2.5 Status Bar

At the bottom of the main window, there is a status bar divided into two parts. The left
side briefly describes the selected operation; the right side indicates operation progress
and results. If you double-click on the operation results, you will see the logs window.

4.3 Navigation

At the top on the Computers pane there are four buttons; clicking them allows you to
add new servers to the tree manually, to start the discovering process, to delete a
server from a tree if needed, or to refresh the Computers Tree.

Computers with Acronis Recovery for MS Exchange Agent already installed are marked
with a green icon.

Select the required server from the tree to perform the required operation (connecting,
installing Acronis Recovery for MS Exchange Agent remotely).

To hide the Computers pane and view Help topics, click on the Show or Hide button
from the menu.

4.4 Management

Acronis Recovery for MS Exchange Management Console allows installation of Acronis
Recovery for MS Exchange components on remote computers. To perform any of these
operations you will need administrator rights on the target machine.

To connect to the server click Connect to a Remote Server in the Pick a Task pane
(see 4.7 “Connecting to a Remote Database Server”). If Acronis Recovery for MS
Exchange Agent is not installed on a server, click Install Acronis Agents in the Pick
a Tool pane (see Chapter 3 “Installation”).

To add a new server to the tree pane, click Add Servers in the Pick a Tool pane (see
4.6 “Adding Servers™).
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4.5 Discovering Servers

The purpose of discovering servers is to find servers on the network automatically and
add them to the list in the Computers pane. The first time the program is executed,
the list in the Computers pane list is empty and you will be prompted to discover
servers. In order to be able to create backup and recovery operations on servers, you
should launch the search or add servers to the list manually.

To discover servers click on the Discover Computers icon from the Computers pane
on the left. You will be asked if you want to search for database servers on the
network. Click YES to do it immediately, or NO to do it later. Discovery will update the
current status of all computers already included in the list.

If, for any reason, a server cannot be found with this tool, you can add it manually to
the tree (see 4.6 “Adding Servers”).

4.6 Adding Servers

If you cannot locate a server with the Discover Computers tool, you can add it to the
tree manually.

You can apply any discovery operation later as required. The operation will add newly
connected servers to the list in the Computers pane. At the same time, discovery will
update the current status of all computers already included in the list.

You can start an Add Computer dialog to add servers to the tree of the Computers
pane in several ways. Here are two:

e Click on the Add Servers icon in the main area
e Click on the Add Servers button in the Computers pane toolbar

1. Enter the server name or IP address manually in a Server field or choose it
from the drop-down list. You can also click Browse to view all available
computers and select the one you want to add.

2. Click OK to add the server to the tree.

4.7 Connecting to a Remote Microsoft Exchange Server

In order to perform any operation on a remote Microsoft Exchange server, you must
first connect to it. Once connected, you can manage tasks: set up backup/restore
options on remote database servers and schedule backup, restore and backup location
clean-up tasks.

To establish a remote connection, select a server in the Computers pane and click
Connect to a Remote Computer in the right pane. If you have connected to this
server previously, Acronis Recovery for MS Exchange will use credentials for accessing
the computer automatically. Otherwise a dialog window will be opened:

e In the Computer field, enter the name or the IP address of the computer
or select a computer from the drop-down list, by clicking the Browse...
button

e To provide credentials for accessing the computer, click the Options>>
button

28



o Specify the username (as <domainluser=) and password on the server you
want to connect to, in the corresponding fields

e Select the Save Password check box if you want to save the password.

Note, that username (including the domain name) and password must be defined
explicitly while connecting to a stand-alone Microsoft Exchange Server.

Having provided all the necessary information for connection, click Connect to
establish connection.

If Acronis Recovery for MS Exchange Management Console cannot connect to
the remote computer which was not rebooted after installing Acronis Recovery
for MS Exchange Agent, connection must be established with explicit
credentials.

As soon as you connect to a database server, you can manage tasks as if it is as a local
computer.

4.8 Remote Installation of Acronis Recovery for MS
Exchange Agent

The remote installation of Acronis Recovery for MS Exchange Agent is described in
detail in 3.3.2.
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Chapter 5. Creating Backup Archives

This chapter provides general information about backup types, describes how to
backup Microsoft Exchange information stores, storage groups or even
mailboxes/public folders, and which options can be set using Acronis Recovery for MS
Exchange.

5.1 General Information

Backup is crucial to maintaining a timely and consistent record of your Microsoft
Exchange servers for recovery in case of failure. Acronis Recovery for MS Exchange
offers an easy and flexible process for creation of backup archives.

5.1.1 What is a backup?

The concept of backing up data is based on copying it to a safe place to restore when
necessary. With an active database you need to backup and protect more than just
your database files and data. Databases include many components, such as transaction
logs, that must be backed up as well to make sure your data will be fully functional
after restoration.

Acronis Recovery for MS Exchange is a tool that backs up the necessary tables, data,
and user-defined objects, but it treats the database as more than just a combination of
files. When the backup procedure starts, Acronis Recovery for MS Exchange finishes all
the active transactions, makes a shapshot of the database and resumes the
transactions immediately. The database idle state is minimal and the backup will be
written to the archive location while the database is online.

Using this process to back up the database ensures that the restored copy will
be fully operational. Since the copy is made according to the snapshot, no
transactions made after the start of the process will be included into the
current backup.

5.1.2 Backup Types

Acronis Recovery for MS Exchange can create full and incremental backups for
comprehensive protection of your data from hardware failure, user errors or even
natural disaster.

A full backup contains all data at the moment of backup creation — a complete storage
group or mailbox/public folder. You can recover the entire database by restoring the
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database from a full database backup to a chosen location. Enough of the transaction
log is included in the backup to let you recover the database to the time when the
backup finished. When the database is recovered, uncommitted transactions are rolled
back. The restored database matches the state of the original database when the
backup finished, minus any uncommitted transactions.

For a small database that can be backed up quickly, it is convenient to use only full
database backups. However, as the database becomes larger, full backups take more
time to finish and require more storage space. Therefore, for a large database, you
might want to supplement full database backups with incremental backups.

A full backup can form a base for further incremental backups or can be used as a
standalone archive.

The incremental backup records all transactions and database modifications made by
each transaction since the last full or incremental backup were created. The
transaction log is a crucial component of the database and, if there is a system failure,
applying the transaction log might be required to bring your database back to a
consistent state. The transaction log file has a fixed size and an automatically
generated filename. After creating the incremental backup, transaction logs will be
truncated.

To choose the appropriate backup type (or types), you have to determine how you
need to make the data available for recovery. Your overall backup strategy defines the
type and frequency of backups as well as the type and capacity of the hardware
required for the archive location. See the next section 5.1.3 “Which Backup Strategy to
Choose?” for our recommendations.

5.1.3 Which Backup Strategy to Choose?

Follow the recommendations below to define the best backup strategy for your
organization:

o Database activity is low to medium:
- Full backup once a week
- Incremental backup every 12 hours
e Database size is small to medium, but activity is high:
- Full backup every two days
- Incremental backup every ten minutes
o Database size is large and activity is high:
- Full backup once a week
- Incremental backup every ten minutes

For advice on creating the best strategy you can also rely upon Acronis Recovery for
MS Exchange Assistant while working with the Create Backup wizard. See 5.2.6 for
detailed information.

We recommend that you do not use several third-party backup tools
simultaneously since backup operations may conflict. Instead, combine
different backup types to protect your data with Acronis Recovery for MS
Exchange.
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5.1.4 Server Roles

As a messaging system that is widely used in both large organizations and small
businesses, Microsoft Exchange Server has always been scalable in both directions.
However, new demands on messaging — such as compliance, security, and disaster
recovery — have created new challenges for delivering a messaging system that works
well in small businesses and large enterprises alike.

Microsoft Exchange Server provides a complete messaging system that can run on a
single server — meaning that all Exchange services reside on one server, as with the
Microsoft Small Business Server product. However, there are significant gains in
deployment, management, and security that come from having a flexible, modular
system that can be installed across more than one machine. Customers would typically
customize their Microsoft Exchange Server 2003 installation, creating specific server
roles manually. In Microsoft Exchange Server 2007, roles are predefined and chosen
during installation. The role selected during installation ensures that only the necessary
services and components are installed.

Microsoft Exchange Server has the following server roles:

e Client Access role - similar to the front-end server in earlier versions of
Microsoft Exchange Server, this server proxies Internet client traffic to the
correct mailbox server.

e Mailbox role - this role hosts user mailboxes stored in databases that can
be replicated or clustered.

e Hub Transport role — this role provides internal routing of all messages —
from Edge servers, Unified Messaging (UM) servers, or between two users
on the same mailbox database. The Hub Transport role is also where
messaging policy is enforced for messages moving within and outside the
organization.

o Unified Messaging role — this role enables PBX integration to allow voice
mail and fax messages to be delivered to Exchange mailboxes, and provides
voice dial-in capabilities to Microsoft Exchange Server.

e Edge Transport role - this server resides outside your internal network
and provides on-premise e-mail security, antivirus, and anti-spam services
for Microsoft Exchange Server.

With the exception of the Edge Transport role, multiple roles or all roles can be
installed on a single system. This is because an Exchange server running the Edge
Transport role in a perimeter network (DMZ) is not a member of Active Directory or the
Exchange organization for security reasons. Another role limitation: clustered mailbox
servers can only be configured with the Mailbox server role.

Acronis Recovery for MS Exchange allows backing up of the Mailbox role only. See
section 5.3 for detailed instructions.

5.1.5 Storage Groups and Information Stores

Exchange Server 2007 Enterprise Edition supports up to 50 storage groups and 50
databases per server. You can configure up to five databases per storage group, and
up to a maximum of 50 databases. Now mailbox data can be distributed across more
databases, and mailbox databases can be distributed across more storage groups, than
in earlier versions of Exchange Server. Exchange Server Standard Edition supports up
to five storage groups and five databases per server. Both Enterprise Edition and
Standard Edition have an unlimited database size limit.
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Thus, an individual database in Microsoft Exchange is only a dependent part of a
storage group, and backing it up separately becomes pointless, because it does not
guarantee a data integrity after restoring.
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5.1.6 Circular Logging

The Microsoft Windows 2000 Active Directory service and the Microsoft Windows
Server 2003 Active Directory service use the circular logging feature to maintain
transactions in the database file (Ntds.dit). The log files are maintained until the data
that they contain is written to the database file. The circular logging feature uses these
log files to recover transactions if the database file is shut down in an inconsistent
state. For example, a power failure or a Stop error can cause a transaction failure. In
Windows 2000 and in Windows Server 2003, there is currently no way to disable the
circular logging feature.

5.1.7 Disaster Recovery Plan

With Acronis Recovery for MS Exchange you can create a Disaster Recovery Plan. This
plan provides all the necessary information about the Microsoft Exchange server in the
form of step-by-step instructions for restoring the entire server in case of failure, a
disaster, or data corruption.

With the Disaster Recovery Plan any person, even non-DBAs, will be able to restore the
system in the shortest possible time. Such a plan also helps to reduce unexpected
issues during the recovery of the Exchange server.

It is recommended that you update and test the disaster recovery plan from time to
time. Doing so will ensure that the company’s staff is prepared, acts efficiently, and
feels practiced in the process of recovering lost or corrupted data.

See Chapter 6 “Disaster Recovery Plan” to learn how Acronis Recovery for MS
Exchange can help you generate the disaster recovery plan.
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5.1.8 Continuous Data Protection

Continuous data protection (CDP, but also may be called continuous backup)
technology makes it possible to save data changes automatically and uninterruptedly,
restoring your data to its exact state at the moment of failure.

When you choose CDP technology during the creation of a backup task, you will have
to schedule only full backups. Acronis Recovery for MS Exchange controls folders with
archived logs and backs up all new logs into a CDP archive. A CDP archive contains a
set of full backups and an archive log, created after the last full backup. As a result,
you can restore data back to the last full backup, or to previously created archived log
backups, stored in the CDP archive.

When a new full backup is created, CDP logs will be truncated.

Please note, before starting any restore process, a CDP task must be stopped. In case
of restoring a whole database, a full backup must be created right after the restoration
process to protect your data.

A CDP task is processed in two ways: in a common task script and in a registry. The
registry’s format is known only by CDP service (CDP agent). Thus, to change or delete
CDP task from Acronis Recovery for MS Exchange Management Console, you also need
a CDP service started.

Note, CDP technology cannot be used while backing up to tapes.

5.1.9 Backing up to Tape Libraries and Tape Drives

Acronis Recovery for MS Exchange supports tape libraries, autoloaders and SCSI tape
drives as storage devices.

Backing up to Tape Libraries and Autoloaders

A tape library is a high-capacity storage device consisting of one or more tape drives
and a loader, which automatically selects and loads multiple tape cartridges identified
with barcodes. Tape libraries having one drive and a loader are known as autoloaders.

Tape libraries are widely used as an efficient repository for long-term stored archival
data. Once the tape library is full, old data is progressively overwritten by new data.
With tape library support, Acronis Recovery for MS Exchange can store several backup
chains from different machines. Please review Acronis True Image Echo Enterprise
Server User's Guide on how to backup to a tape drive in the network (section 3.8.3
“Setting up Backup to a Tape or a Tape Library in the Local Network” of the Echo
User’s Guide).

Backing up to Tape Drives

SCSI tape drives are accessible both remotely using the Acronis ® Backup Server
(shipped with Acronis True Image Echo Enterprise Server) and locally when they are
connected to the computer that is being backed up.

The locally connected tape drive will appear in the list of backup destination devices
along with other available drives. For instructions on how to enable backup to a tape
drive connected to a remote computer, see Acronis True Image Echo Enterprise Server
documentation section 3.8.3 “Setting up Backup to a Tape or a Tape Library in the
Local Network” of the User’s Guide.
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Backup and restore operations on a tape drive proceed in the same way as with other
devices with the following exceptions.

1. You do not have to provide filenames for backups.

2. As soon as the tape is full and the Acronis Recovery for MS Exchange
Management Console is connected to the computer, a dialog window with a
request to insert a new cartridge will appear.

3. If the tape already contains data, but is not full, new contents will be
appended.
You may experience short pauses that are required to rewind the tape.

You may experience short pauses when the tape rewinds. A low-quality and
old tape, or dirt on the magnetic head, may lead to pauses that can last up to
several minutes.

Acronis Recovery for MS Exchange can back up to remote tape drives when using
Acronis Backup Server (shipped with Acronis True Image Echo Enterprise Server).

5.2 Backing up Databases

To restore lost data or roll back Microsoft Exchange Server databases to a certain
state, you must first create a backup file. The Backup Information Stores wizard
allows you to schedule the creation of archives and set the required options.

To launch the wizard, click on the backup operation icon in the main workspace.

You can use <A/t>+</MN> to go to the next page and <A/t>+<B> to go to the
previous page of any Acronis Recovery for MS Exchange wizard.

5.2.1 Defining a Backup Strategy

In the first step of the Create a Backup wizard you will define the backup strategy.
Acronis Recovery for MS Exchange provides four ways to define the strategy:

e Schedule a backup task with Acronis Recovery for MS Exchange Assistant
e Schedule a backup task manually
e Use continuous data protection technology

o Create a backup now

If you are not sure which backup strategy to choose, use Schedule a backup task
with Acronis Recovery for MS Exchange Assistant (selected by default). See
5.2.6 for details.

If you know which backup type to use for your data, select the Schedule a backup
task manually option. In this case you will have to define backup types and schedule
parameters for backup tasks.

Select Use continuous data protection technology option to enable CDP. In this
case you will have to schedule your full backups. See section 5.1.8 for more details.

To immediately run a backup task once select the Create a Backup Now option. A
full backup will be created.
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While creating a backup task, you have to select, which way to back up your data.
Note, transaction logs files require considerable disk space, so you will have to delete
(or move to another place for storing) them manually, taking into account which files
are safe to remove.

For more information about backup types see 5.1.2 “Backup Types”.

5.2.2 Specifying a Task Execution Account

In this step of the Backup Information Store wizard you specify an account that is
valid for the computer housing databases you want to back up — task execution
account. These credentials will be used during each task execution for connecting to
the server and by default for connecting to the Microsoft Exchange Server.

The task will run as if it was started by the specified user.

Enter the user name and password, then click Next. Note, the domain name must also
be specified if the user is a member of a domain (DOMAIN\Username).

Note, this step will be skipped if in the first one you selected the Create a
backup now option.

5.2.3 Selecting Items to Back Up

In this step of the wizard you have to specify which items to back up.

In the left pane of the window select an information store with Microsoft Exchange
installed and expand it to view and specify storage groups to back up. In case an
information store is selected, all associated storage groups will also be selected.

Information on the selected item is displayed in the right pane of the window:
information store name, installed operating system and the number of storage groups.

Selecting Information Stores to Back Up

When selecting an information store to back up Acronis Recovery for MS Exchange will
automatically back up all of the storage groups associated with this information store.

A list of information stores can be obtained, with the connected user’s
privileges that cannot be changed.

Screenshot

Note, Acronis Recovery for MS Exchange does not back up the Active
Directory. This means, that even there were any changes after a backup
archive was created, after restoring the Microsoft Exchange Server structure
will remain the same as it was before the restoration process. As a result,
while restoring information stores, only storage groups will be restored one by
one. For example, mailboxes created or deleted after the last backup, will still
exist phisically after the restore, but they will not be mounted, and so will not
be usable.

The right pane will display the information store name, Microsoft Exchange version, the
installed operating system and amount of storage groups.
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Selecting Storage Groups to Back Up

Select the specific storage group you want to back up. The right pane will display its
name, size, number and total size of associated databases, as well as circular logging
status (enabled/disabled).

After selecting the appropriate object for back up, click Next to continue.

5.2.4 Selecting a Backup Archive Location

Acronis Recovery for MS Exchange supports the following places and media for backup
destinations:

e Local HDD
e Network shares, SAN, NAS
e FTP

e Tape drives, Autoloaders, Tape libraries

e Acronis Backup Server (shipped with Acronis True Image Echo™ Enterprise
Server)

Acronis Backup Server

This software application, when installed on a networked computer,
automatically manages backup archives and retention policies for the
specified location and ensures optimal usage of storage space. Outdated
archives will automatically be deleted as specified in the retention policies set
by the administrator. In addition, Acronis Backup Server facilitates the
creation and execution of group backup tasks.

Acronis Backup Server is shipped with Acronis True Image Echo Enterprise
Server.

We recommend you store the archives for each task in a separate locations to avoid
confusion during recovery.

Note, the further you store the backup archive from the original location, the safer it
will be in case of data damage. For example, saving the archive to another hard disk
will protect your data if the primary disk is damaged. Data saved to a network disk or
backup server will survive even if all your local hard disks are down.

Select the desired archive location from the folders tree or specify a backup location in
the Folder field.

In case you have chosen an ftp server as a backup location, provide login and
password for this server in a special pop-up window which appears after you select this
item from the tree.

Important! Do not enter the login and password in the Folder field
(“ftp://login.:password@ftpserver’); the product will not process this command.

Acronis Recovery for MS Exchange guarantees the integrity of the backup
chain only in a separate archive. Thus, creation of a new archive will start a
new chain of backups. Acronis Recovery for MS Exchange behavior does not
depend on what you want to back up (the entire information store or only a
separate storage group). By default, transaction logs are truncated before
creating such a chain to decrease the archive size and duration of the backup
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operation. You can change this behavior by specifying additional settings in
backup options (see 5.4.7 for detailed information).

Please note that unsupported Acronis Backup Server versions will not be
displayed in the Acronis Backup Servers list. To provide compatibility with
Acronis Recovery for MS Exchange, please install most up-to-date version,
available at: http://www.acronis.com/enterprise/download/ATIBS .

Note, Acronis Recovery for MS Exchange does not display mapped network
drives in the Folders tree.

Acronis Recovery for MS Exchange allows you to clean storage places to avoid storing
out of date archives. See Chapter 8 “Backup Location Clean-up” for details.

5.2.5 Using Acronis Recovery for MS Exchange Assistant

Acronis Recovery for MS Exchange Assistant will help you define backup strategy and
creation parameters. You will be prompted to answer a few questions, and Acronis
Recovery for MS Exchange Assistant will choose and schedule the appropriate backup
type for protecting your company’s databases from loss or damage (see a table of
backup strategies at the end of this document).

Performance

Decide what is most important to your operation — a strategy that requires less storage
space or faster data recovery.

Select an option:

e Quick backup and smaller backup archives - backups are created fast
and occupy less space. However, recovery requires more time and you
cannot restore data to a point-in-time. This option is set by default.

e Medium backup and recovery speed with average archive size -
backups require an average amount of disk space and backup speed is
normal. No restoration to a point-in-time.

e Quick recovery but backups require more storage space - backups
will take more time to be created and occupy more disk space in
comparison to a quick backup. Recovery is faster and there is an
opportunity to specify a point in time to restore data to.

Click Next to continue.

Acceptable Data Loss

At this step specify a period of time when data changes significantly. This will help
Acronis Recovery for MS Exchange Assistant define the schedule for backup creation —
how often to run the backup operation and which backup type to choose.

Select one of the following options:
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e 10 Minutes — use when significant changes occur at least every ten
minutes (this option is available only while backing up an information store
and is disabled for mailboxes because the backup technology does not allow
specifying such short periods of time)

e Hour — select this option if you want to back up the selected data hourly

o Day - select this option if you want to back up the selected data daily

Click Next to continue.

Server Load During a Week

Specify the workload distribution on the Exchange server during a week. The Assistant
will use this information to define a backup schedule according to your company’s
server’'s load. The load information is used to determine when and what type of
backups to create to avoid data loss (backup creation frequency), as well as when to
execute the operation.

In the table there are three rows representing three levels of load (High, Medium and
Low), and seven columns representing the days of the week.

By default the most widely used pattern is specified (selected cells are highlighted in
blue). To change the value for a certain day, click the appropriate cell.

Click Next to continue.

Server Load During a Day

Specify workload distribution on the Exchange server throughout the day. As in the
previous step, this information will help to define a backup schedule that complements
the peaks and valleys of your company’s server loads.

In the table there are three rows representing three levels of load (High, Medium and
Low), and 24 columns representing the hours of the day.

By default the most widely used pattern is specified (selected cells are highlighted in
blue). To change the value of a particular hour, click the appropriate cell.

Initial Task Starting
Specify a time for applying the selected scheme:

o Now - select this option to execute the scheduled task immediately after
you finish the wizard

¢ On the specified date and time — the selected scheme will be applied on
the specified date. Note that if there is no full backup when the first
incremental backup is to be performed, a full backup will be performed
independently of the actual date on which it is scheduled. You may consider
setting this date on the day of the week when your server load is not high

Click Next to view (and change if necessary) the schedule for backup tasks, created
by Acronis Recovery for MS Exchange Assistant.
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Table of Backup Strategies

The table below describes different backup strategies according to your requirements
for storage space and speed. The final strategy created by Acronis Recovery for MS

Exchange Assistant will be displayed in a Schedule page (see 5.2.6 for details).

Performance
Data change : : Quick
rate 9¢ | Backup Type | Quick backup | Medium recovery and
and smaller archive size .
. . large archive
archive size and speed .
size
) Full Week 2 days Day
10 minutes : . :
Incremental 10 minutes 10 minutes 10 minutes
Full Week 2 days Day
Hour
Incremental 1 hour 1 hour 1 hour
Full Week 2 days Day
Day
Incremental 12 hours 12 hours 12 hours

5.2.6 Setting Backup Scheduling Parameters

If you used Acronis Recovery for MS Exchange Assistant, it will create a schedule for
the choices you made. Click Edit to change the existing schedule settings.

If you decided to define the backup strategy manually, you have to set a schedule for
each backup type. See Chapter 9 “Scheduling Tasks” for detailed information.

Click Add to add new schedule settings for the appropriate type (full or transaction
logs). Clicking Delete will allow you to delete the existing schedule settings.

All the settings you made are displayed in the Result field at the bottom of the
window. To save your settings, click OK.

To quit task scheduling without saving, click Cancel.

Note, Acronis Recovery for MS Exchange allows you to set multiple schedules for one
task. For example, you should not only backup your data once a week, but also on the
last day of each month. You can specify Weekly and Monthly parameters to have the
necessary operation scheduled.

5.2.7 Backup Options

Select the backup options (pre/post commands, compression level etc.). You may Use
default options (see 5.4 for detailed information about backup options) or Set the
options manually. If you set the options manually, the settings will only be applied
to the current backup task.

5.2.8 Specifying a Task Name and Providing Comments

On the Task Name and Archive Comments wizard page, you can provide a hame
and comments for the backup task.
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Enter a task name in the Task Name field to identify and organize tasks by operation
(edit, delete, etc.).

You may provide comments for the archives you create. The backup file size and
creation date are automatically appended to the description, so you do not need to
enter this information.

5.2.9 Backup Summary

The final stage of the backup is the summary window, which displays the list of
operations to be performed.

Click Finish to save the created schedule or start the backup creation task
immediately. You will be redirected to the Task List automatically, where you can view
and edit created tasks.

5.3 Backing up Mailboxes

Brick-level (document level) backup is the most flexible type of backup. It offers
advanced configuration options and performs backups at folder levels and quick
restoring at separate messages level, allowing the most accurate level of restore. It
also supports advanced filtering during backup.

Use Mailbox backup and restore when you want the flexibility to back up individual
mailboxes, public folders and use mail level filters.

Also you can restore mailboxes and even separate e-mails from database backups.

5.3.1 Defining a Backup Strategy

In the first step of the Back up Mailboxes wizard you will define the backup strategy.
Acronis Recovery for MS Exchange provides three ways to define the strategy:

e Schedule a backup task with Acronis Recovery for MS Exchange Assistant
e Schedule a backup task manually

o Create a backup now

If you are not sure which backup strategy to choose, use Schedule a backup task
with Acronis Recovery for MS Exchange Assistant (selected by default). See
5.2.6 for details.

If you know which backup type to use for your data, select the Schedule a backup
task manually option. In this case you will have to define backup types and schedule
parameters for backup tasks.

To immediately run a backup task once select the Create a Backup Now option. In
this case a full backup will be created.

For more information about backup types see 5.1.2 “Backup Types”.

5.3.2 Specifying a Task Execution Account

In this step of the Create a Backup wizard you specify an account that is valid for the
computer housing Mailboxes you want to backup — task execution account. These
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credentials will be used during each task execution for connecting to the server and by
default for connecting to the Microsoft Exchange.

The task would run as if it was started by the specified user.

Enter the user name and password, then click Next. Note, the domain name must also
be specified if the user is a member of a domain (DOMAIN\Username).

Note, this step will be skipped if you selected the Create a Backup Now in
the previous step (5.3.1 Defining a Backup Strategy).

5.3.3 Selecting Items to Back Up

In this step of the wizard you have to specify which items to backup: mailboxes and/or
public folders. Select an information store, the required storage group, then expand it
to view its mailboxes and public folders. In case an information store is selected, all
associated storage groups will also be selected.

Information on the selected item is displayed in the right pane of the window:
information store name, installed operating system and the number of storage groups.

Selecting Mailboxes to Back Up

Choose a storage group and mailbox store from which you want to back up a mailbox.
Information (size and number of mailboxes) about the selected items will be displayed
on the right.

In the list, specify the mailbox (or separate folders) you want to back up. Information
about size, number of folders and subfolders, as well as the total number of e-mails
will be displayed on the right.

A list of information stores can be obtained, with the connected user's
privileges that cannot be changed.

Selecting Public Folders to Back Up

Choose a storage group, public folder store and public folder from which you want to
back up a specific folder. Information about the selected items will be displayed on the
right.

In the list, specify the public folder you want to back up. Information about the size,
number of folders and subfolders, as well as the total number of e-mails will be
displayed on the right.

After selecting the appropriate object for back up, click Next to continue.

5.3.4 Excluding Objects

In this step the Backup wizard specify objects you want to exclude from the backup
archive to be created.
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Select Exclude the following objects from the backup to enable excluding
options and then select the required ones:

e “Deleted Items” folder — exclude the “Deleted Items” folder from the
backup file to be created

e “Sent Items” folder — exclude the “Sent Items” folder from the backup
file to be created

e Items that were modified before — select day, month and year to
exclude objects modified earlier than the chosen date

e Attachments larger than — select this item and specify the maximum
attachment size to be included into the backup file

e The following types of attached files — select this item to exclude
attachments with files of the types listed below. Also you can change the list
of file types by clicking Specify types of files to exclude and delete or
add the required ones. Note, you can enter several file extensions under one
name by separating them with commas.

5.3.5 Selecting a Backup Archive Location

Acronis Recovery for MS Exchange supports the following places and media for backup
destinations:

e Local HDD
¢ Network shares, SAN, NAS
e FTP

e Tape drives, Autoloaders, Tape libraries

e Acronis Backup Server (shipped with Acronis True Image Echo™ Enterprise
Server)

We recommend that you store the archives of each task in a separate location to avoid
confusion during recovery.

Note, the further you store the backup archive from the original location, the safer it
will be in case of data damage. For example, saving the archive to another hard disk
will protect your data if the primary disk is damaged. Data saved to a network disk or
backup server will survive even if all your local hard disks are down.

Select the desired archive location from the folders tree or specify a backup location in
the Folder field.

In case you have chosen an ftp server as a backup location, provide a login and
password for this server in a special pop-up window which appears after you select this
item from the tree.

Important! Do not enter the login and password in the Folder field
(“ftp.//ogin.password@ftpserver”), the product will not process this command.
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Acronis Backup Server

This software application, when installed on a networked computer,
automatically manages backup archives and retention policies for the
specified location and ensures optimal usage of storage space. Outdated
archives will automatically be deleted as specified in the retention policies set
by the administrator. In addition, Acronis Backup Server facilitates the
creation and execution of group backup tasks.

Acronis Backup Server is shipped with Acronis True Image Echo Enterprise
Server.

Select the desired archive location from the folders tree or specify a backup location in
the Folder field.

Acronis Recovery for MS Exchange guarantees the integrity of the backup
chain only in a separate archive. Thus, creation of a new archive will start a
new chain of backups.

Please note that unsupported Acronis Backup Server versions will not be
displayed in the Acronis Backup Servers list. To provide compatibility with
Acronis Recovery for MS Exchange, please install the up-to-date version,
available at: http://www.acronis.com/enterprise/download/ATIBS .

Note, Acronis Recovery for MS Exchange does not display mapped network
drives in the Folders tree.

Acronis Recovery for MS Exchange allows you to clean storage places to avoid storing
out of date archives. See Chapter 8 “Backup Location Clean-up” for details.

5.3.6 Using Acronis Recovery for MS Exchange Assistant

Acronis Recovery for MS Exchange Assistant will help you with define backup strategy
and creation parameters. See section 5.2.5 for detailed information on using Acronis
Recovery for MS Exchange Assistant.

5.3.7 Setting Backup Scheduling Parameters

If you used Acronis Recovery for MS Exchange Assistant, Acronis Recovery for MS
Exchange will offer the appropriate schedule for the choices you made. Click Edit to
change existing schedule settings.

If you decided to define the backup strategy manually, you have to set a schedule for
each backup type. See Chapter 9 “Scheduling Tasks” for detailed information.

Click Add to add new schedule settings for the appropriate type (full or transaction
logs). Clicking Delete will allow you to delete the existing schedule settings.

All the settings you made are displayed in the Result field at the bottom of the
window. To save your settings, click OK.

To quit task scheduling without saving, click Cancel.

Note, Acronis Recovery for MS Exchange allows you to set multiple schedules for one
task. For example, you should not only backup your data once a week, but also on the
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last day of each month. You can specify Weekly and Monthly parameters to schedule
the necessary operation.

5.3.8 Backup Options

Select the backup options (pre/post commands, compression level etc.). You may Use
default options (see 5.4 for detailed information about backup options) or Set the
options manually. If you set the options manually, the settings will only be applied
to the current backup task.

5.3.9 Specifying a Task Name and Providing Comments

On the Task Name and Archive Comments wizard page, you can provide a name
and comments for the backup task.

Enter a task name in the Task Name field to identify and organize tasks by operation
(edit, delete, etc.).

You may provide comments for the archives you create. The backup file size and
creation date are automatically appended to the description, so you do not need to
enter them.

5.3.10 Backup Summary

The final stage of the backup is the summary window, which displays the list of
operations to be performed.

Click Finish to save the created schedule or start the backup creation task
immediately. You will be redirected to the Task List automatically, where you can view
and edit created tasks.

5.4 Setting Default Backup Options

Acronis Recovery for MS Exchange lets you set the backup options you want to use as
default for future tasks.

To edit the default backup options, select Tools -> Options from the main program
menu.

You will also still be able to edit the backup options while creating a backup task.

5.4.1 Pre/Post Commands

You can specify commands (or even batch files) that will be automatically executed
before and after the backup procedure. For example, you may want to start/stop
certain Windows processes, or check your data before starting the backup operation.

You can use commands set by default, as well as specify your own commands.

Select Use commands, type commands manually or click Edit to configure the
command:
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e Select commands to be executed before the backup process starts in the
Before backup process field. To create a new command or select a hew
batch file click the Edit button.

« Select the command to be executed after the backup process ends in the
After backup process field. To create a new command or select a new
batch file click the Edit button.

5.4.2 Compression Level

Select the compression level for the backup. With higher compression ratios the
archive file size will be smaller, but the backup process may take longer.

You can choose one of the compression levels for a backup archive:
* None - the data will be copied without any compression
 Normal - the recommended data compression level (set by default)
« High - higher archive compression level
e Maximum - maximum backup archive compression
¢ Ultimate — ultimate level of compression

Generally, it is recommended to use the default Normal compression level. You might
want to select Maximum compression so the backup archive occupies less storage
space.

5.4.3 Backup Priority
You can set up the backup process priority:

e Low - the backup process will run slower, but it will not influence other
processes running on your computer

* Normal - the backup process will run with normal priority

e High - the backup process will run faster, but it may influence other
processes running on your computer

Changing the priority of a backup process can make it run faster or slower, but it can
also adversely affect the performance of other programs running simultaneously. The
priority of any process running in the system determines the amount of CPU usage and
system resources allocated to that process. Decreasing the backup priority will increase
the number of compute cycles available to other processes.

5.4.4 Backup Protection

Password
The preset is No Password.

You can password protect your archives so that they will be inaccessible to others.
Enter a password in the text field and confirm it. The password is case sensitive.
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Please keep in mind that in the Restore Data wizard, Acronis Recovery for MS
Exchange will ask for a password after you select a folder within the archive location.
Only those archives that were protected with the password you typed in or non
password-protected archives will be displayed. Best practices suggest using the same
password for backup archives in the same folder within the archive location.

Encryption

After setting a password, you can choose to encrypt the backup with an industry-
standard AES cryptographic algorithm for advanced security.

To set up backup encryption, select one of the following encryption types:
¢ None — backups will not be encrypted
e AES 128 - the quickest encryption method available (set by default)
e AES 192 - encryption will take longer than 128-bit, but is more secure

e AES 256 - requires the most amount of time to cipher, but it is also the
most secure setting available

5.4.5 Backup Type Substitution

You need to create full backup of data before creating an incremental one. If for some
reason a full backup does not exist, you will need to create a full backup independently
of the backup strategy you have configured.

Specify the schedule of creating backups so that a full backup will be created first (see
Chapter 9 “Scheduling Tasks” for detailed information), or select the check box If
creation of a selected type of backup failed, try to create a full backup.

5.4.6 Bandwidth Throttling

You can limit the bandwidth used by the backup process so that network resources will
be available for other processes.

To set the desired data transfer speed, check the Enable bandwidth throttling
parameter. Select a maximum bandwidth value from the drop-down list or enter a
value manually.

5.4.7 Additional Settings

1. Validate backup once it has been created

When enabled, the program will verify the integrity of the archive immediately after it
is created.

To validate the archive data integrity you must have all of the backups in the
series (full and incremental backups) available in the same location. If any of
the successive backups are missing, validation will not be possible.

2. Backup metadata

a7




This parameter is selected by default, which allows backing up metadata.
3. Overwrite data on the tape

Select this parameter if you use tapes as a backup location and want to choose an
overwrite mode. See 5.1.9 for detailed information.

4. Fast incremental backup

Select this parameter to create only brick-level (document level) backup, which
provides quicker restoring of individual e-mails and mailboxes.

5. Do not truncate transaction logs

This parameter is available only while backing up information stores and storage
groups will be enabled only if you create independent full backups (Acronis Recovery
for MS Exchange will check the specified backup strategy). This parameter is selected
by default.

In all other cases Acronis Recovery for MS Exchange will truncate transaction logs,
since creating an archive chain (full and incremental backups) is impossible with
transaction logs not truncated after the first full backup.
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Chapter 6. Disaster Recovery Plan

It is extremely important for all organizations and users to have detailed instructions
describing the process for recovering data quickly and efficiently in case of disaster — a
Disaster Recovery Plan. This plan should contain all of the required information to
guide someone through the recovery process. When creating a Disaster Recovery Plan,
be sure to include scenarios and procedures for different kinds of disaster situations
(loss of the Exchange server, data corruption, complete loss of storage groups etc).

The Disaster Recovery Plan should include step-by-step instructions for every possible
type of disaster, as well as each server’'s hardware and software configuration.

With the Create Disaster Recovery Plan wizard, you can generate and view a
Disaster Recovery Plan for your database server immediately, or schedule to receive it
via e-mail after each update.

6.1 Viewing a Disaster Recovery Plan Immediately

Launch the Disaster Recovery Plan Creation wizard by clicking on the Disaster
Recovery Plan operation icon in the main workspace.

1. In the first step of the wizard, choose the View the Disaster Recovery
Plan for the selected database option to generate and view the Disaster
Recovery Plan for the selected databases immediately

2. Select the items you want to obtain the Disaster Recovery Plan for

3. Choose whether you want to receive the Disaster Recovery Plan by e-malil
or to view it in HTML format

4. If in the previous step you selected to receive the Disaster Recovery Plan by
e-mail, you will need to specify the e-mail parameters

Specify the e-mail account that will be used for sending the Disaster
Recovery Plan. Provide the e-mail address to which the plan will be sent
and the outgoing SMTP server name. You can specify several e-mail
addresses separating them by commas

A Username and a password may also be needed if the SMTP server
requires authentication.
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You can check if the settings are correct by clicking the Send test E-Mail
message button

5. The final stage of the Disaster Recovery Plan Creation wizard is the
summary window, which display the list of operations to be performed.

Click Finish to obtain the Disaster Recovery Plan immediately.

In the latter case an e-mail will be sent to the address you specified or a
HTML version of the Disaster Recovery Plan will be opened in your web
browser after you click Finish.

6.2 Scheduling Receipt of the Disaster Recovery Plan

Launch the Disaster Recovery Plan Creation wizard by clicking on the Disaster
Recovery Plan operation icon in the main workspace.

1. In the first step of the wizard, use the Define databases for which you
want to receive the plan each time it is updated option to choose
which items to generate the Disaster Recovery Plan for each time any
changes occur. The updated version of the plan will automatically be sent to
e-mail addresses you specify.

2. Select the databases for which you want to obtain the Disaster Recovery
Plan.

3. Specify the e-mail account that will be used for sending the Disaster
Recovery Plan. Provide the e-mail address to which the plan will be sent
and the outgoing SMTP server name. You can specify several e-malil
addresses separating them with commas.

A Username and a password may also be needed if the SMTP server
requires authentication.

You can check if the settings are correct by clicking the Send test E-Mail
message button.

4. The final stage of the Disaster Recovery Plan Creation wizard is the
summary window which displays the list of operations to be performed.

Click Finish to schedule receipt of the Disaster Recovery Plan after each
update.

6.3 Summary

Thus, in case of disaster, you only need to take the most recent version of the Disaster
Recovery Plan and follow the instructions to restore your databases.
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Chapter 7. Backup Location Clean-up

Sooner or later the backups you create will fill up the assigned storage space. Acronis
Recovery for MS Exchange allows you to clean up backup locations by specifying how
long to store the archive and/or the maximum number of full backups to store. By
default, these options are disabled.

Launch the Backup Location Clean-up wizard by clicking on the icon in the main
program window.

7.1 Specifying a Task Execution Account

In the first step of the Backup Location Clean-up wizard, you have to specify a local
or domain account which is valid on the computer where the archives are stored — a
task execution account. The specified account must have rights and permissions to
manage files in the backup location you want to clean up.

Enter the user name and password then click Next. The domain name must be
specified if the user is a member of a domain (DOMAIN\Username).

7.2 Selecting the Backup Archive Location

Select the backup location you want to clean from the tree, or manually specify the
path to it in the Path field below the tree. You can also select Acronis backup locations
(such as Acronis Backup Server).

The following resources may also be selected for backup locations:
o Entire disk or disk folder
e Network share, SAN, NAS
e FTP

e Acronis Backup Server

Important! The backup location clean-up operation will be performed for the
selected location and affect all database archives, created by Acronis Recovery
(even if these are archives for Microsoft Exchange, Microsoft SQL Server, or
Oracle).
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Click Next to provide a password, if one is required, for archives in the selected
backup location.

B8 Rotation Cleaning Wizard

Place selection for rotation

< Local Disk (C:)

# 3 Documents and Settings Fied Disk Drive

= h Program Files Free Space: 1.005 GB
3 RECYCLER Total Size: 3,991 GB
®) System Yolume Information
® 3 winpows

3% Acronis Backup Servers

=] ﬁ Computers Mear Me
.gfi FTP Connections

Folder: |1y o

@ﬂelp [ < Back ][ Iext = ] [ Cancel ]

7.3 Providing a Password

If there are any password-protected backup archives in the location you have selected
(see 7.2), you will need to enter the password to clean up the archive location.

g Rotation Cleaning Wizard

Enter Password

Ent: d to

If there are password-protected archives in the place that vou want be processed, you should enter the password For these archives.

Erter the password: 2000009

Q)delp < Back ][ Mext = ] [ Cancel

Click Next to continue.

7.4 Specifying Cleaning Options

At this step specify the GFS or Simple (selected by default) scheme to use for location
cleaning.
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7.4.1 GFS Scheme

Select this option to enable GFS clean-up scheme.

GFS (Grandfather-Father-Son) scheme will keep three sets of backups in the selected
location. This scheme, if chosen, is activated on the day the first full backup was
created: all backup archives (full and incremental) for the current week (7 days
starting from the day of creating the first full backup); one full backup for each week
of the current month; and finally one full backup for each month of the current year.

You may also specify notification receiving, if free space in the backup location is
lower, that the selected size (in GB). You will receive an e-mail, but no archives will be
deleted automatically. To specify e-mail parameters, go to the Tools > Options (see
11.1 “E-mail Notifications” for more details).

7.4.2 Simple Scheme

Select Use the simple scheme option to specify the following parameters:

Minimum free space

Select this parameter to check the remaining free space and to specify the minimum
size in GB. With this option selected, you will be able to specify the minimum number
of full backups to keep and the minimum lifetime of archives to store (in days).

Maximum number of full backups

Select the Remove the oldest archives if the total number of full backups is
more than check box and type or select the maximum number of full backup archives
to store.

Maximum archive’s lifetime

Select the Remove archives that are more than check box and type or select the
maximum number of days to store archives in the day(s) old box.

7.5 Schedule Cleaning

Acronis Recovery for MS Exchange allows you to schedule backup location clean-up.
Specify the schedule that is the best for your needs (see Chapter 9 “Scheduling Tasks”
for detailed information).
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7.6 Backup Location Clean-up Summary

The final stage of the backup location clean-up is the summary window, where the list

of operations that will be performed is displayed.

Click Finish to save the created schedule or start the backup location clean-up task

immediately.
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Chapter 8. Restoring the Backup Data

Acronis Recovery for MS Exchange restores storage groups and mailboxes from
previously created backup archives.

8.1 Restoring Information Stores

Launch the Restore Information Store wizard by clicking on the restore operation
icon in the main workspace.

8.1.1 Restoration Time Selection

In the first step of the Restore Data wizard you will select when to run the
restoration process. There are two choices:

o Now — select this option to execute the restore operation immediately after
you finish the wizard

e On schedule — select this option to schedule the operation

¢ When restoring on bare metal — this option is available if Acronis True
Image Echo Enterprise Server is installed and allows restoring the whole
production server on a bare metal (see section 2.3.2 for details)

8.1.2 Specifying a Task Execution Account

In this step of the Restore Data wizard, you are specifying an account that is valid on
the computer where the data you want to restore is located — a task execution
account. These credentials will be used during each task execution for connecting to
the server.

The task will run as if it was started by a specified user.

Enter the Username and password then click Next. The domain name must be
specified if the user is a member of a domain (DOMAIN\Username).

8.1.3 Selecting a Backup Location

Select the appropriate backup location in the tree or specify the path to it manually in
the Path field below the tree. Acronis Recovery for MS Exchange stores up to ten
locations for the last archives created in a special folder — Recent Backup Locations
- s0 you can easily locate the appropriate archive.
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You can also select specific Acronis backup locations (such as Acronis Backup Server).
The following resources may also be selected as backup locations:

o Entire disk or disk folder

e Network share, SAN, NAS

o FTP

e Tapes, Autoloaders, Tape Libraries

e Acronis Backup Server

The number of archives in the selected folder is displayed in the right pane.

Click Next to continue.

8.1.4 Selecting a Backup Task

If several backup tasks use the same location to store archives, you have to select the
task you want to restore from.

Note, Acronis Recovery for MS Exchange does not protect archives form
possible physical corruption. In case you try to restore data from the
corrupted archive, an error message will appear and the restore task will not
be executed. We recommend you to rename or delete the last archive’s slice
(since the corrupted one and all subsequent slices should be renamed or
deleted), and then try to execute the restore task once more.

Click Next to continue.

8.1.5 Providing a Password

If there are any password-protected backup archives in the location you have selected
(see 9.1.3), you will need to enter the password to restore your data from the
archives.

Click Next to continue.

8.1.6 Restore Point Selection
Specify to which state you want to restore your data.

Acronis Recovery for MS Exchange offers four ways for restoring your data:

e to the point of failure — the data will be restored to the state at the point
of failure. To be able to restore to the point of failure, a chain of backed up
logs and also newly created log files (including an active log) must be
available in the selected location. Otherwise only restoring to the time of
the latest backup is available. Keep in mind, that restoring to the point of
failure can take a long time.

e to the time of the latest backup — choosing this option will restore your
data to the state when the last backup was created. Restoring to the latest
backup will be faster, than restoration to the point of failure.
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e to a specific point in time - Acronis Recovery for MS Exchange allows
you to specify a date and time to restore your data from. Note, to be able
to restore to a specific point in time, Microsoft Exchange transaction logs
must be backed up. Data will be restored to the time of the last created
backup before the specified time, and then transaction logs will be applied.

o from the selected backup — select this option to choose a backup from
which to restore. A list of backups will be available by clicking on the Select
from the list of backups link. Choose the backup you want to restore
from and click OK.

To use special recovery modes, enable the corresponding parameter and select
Acronis Active Restore or Dial tone recovery.

Select Dial tone recovery in order to recover e-mail service in the first place, this will
enable users to send and receive e-mail while all other data is being restored. You can
use dial tone recovery only while restoring data from the latest backup. Dial tone
recovery may be used only with Microsoft Exchange Server 2007 (see 8.6 for details).

Restart an e-mail application after the restoration process is completed to bring data to
up-to-date state.

To overwrite previously created dial tone databases generated by third-party tools,
select the corresponding check box. This step eliminates the need to delete the old
databases manually.

After selecting the appropriate option click Next to continue.

8.1.7 Content Selection

Acronis Recovery for MS Exchange restores information stores and separate storage
groups. Select a database server from the tree in the left pane.

Restoring Information Stores

Choose an information store to restore. Information about this item will be displayed
on the right. Note, only databases, which existed before creating a full backup, will be
displayed. Newly created databases cannot be restored only from storage groups’
transaction logs. In terms of this, we recommend you to create full backups after new
databases are created.

Important! While restoring an information store, e-mail service will not be
available, i.e. users will not be able to send and receive e-mails.

Restoring Storage Groups
Choose the storage group to restore.

You can restore storage groups to its original location, choose another storage group
as a new location or restore to Recovery Storage Group (in this case only one storage
group can be restored).
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Important! After a successful completion of a database restore process, the
database will remain in dismounted. One of the possible ways to avoid this
situation is increasing permission privileges for the database being restored.
For more details please visit http://support.microsoft.com/kb/827283.

Click Next to continue.

8.1.8 Restore Options

Select the options for the restoration process (Pre/Post commands, restoration process
priority etc.). You can Use default options (See 8.2 “Setting Default Restore
Options” for more information.) or Set the options manually. In the latter case, the
settings will be applied only to the current restore task.

8.1.9 Selecting Start Parameters

You can run a restore task manually or specify the frequency (Daily, Weekly or
Monthly). See Chapter 9 “Scheduling Tasks” for detailed information.

8.1.10 Echo Task Selection

When restoring on bare metal, you need to select the Acronis True Image Echo
Enterprise Server task responsible for the restoration of system volumes and volumes
where Microsoft Exchange Server is located. You can do it either immediately after
Restore Data wizard completes or do it manually later.

Choose one of the following actions:

. Do not run Echo task - in this case, you will have to select Acronis True
Image Echo Enterprise Server task manually later.

o Run the following Echo task - in this case, you have to select Acronis
True Image Echo Enterprise Server task from the list below. The selected
task will be started immediately after Restore Data wizard completion.

Having selected the appropriate action, click Next to continue.

8.1.11 Restore Summary

In the final step, the restoration summary is displayed. Up to this point, you can click
Back to make changes in the created task.

If you click Cancel, no databases will be restored.

Important! Clear the Microsoft Outlook cache after the restore operation
completion for the correct data representation.

Click Finish to save the schedule or start the restore task immediately.

8.2 Restoring Mailboxes

Launch the Restore Mailboxes wizard by clicking on the restore operation icon in the
main workspace.
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http://support.microsoft.com/kb/827283

8.2.1 Restoration Time Selection

In the first step of the Restore Data wizard you decide when to run the restoration
process. There are two choices:

e Now - select this option to execute the restore operation immediately after
you finish the wizard

e On schedule — select this option to schedule the operation

8.2.2 Specifying a Task Execution Account

In this step of the Restore Data wizard, specify an account that is valid on the
computer where the backup archives you want to restore are located — a task
execution account. These credentials will be used during each task execution for
connecting to the server and for connecting to the Microsoft Exchange.

Thus, the task will run as if it was started by the specified user.

Enter the Username and password then click Next. The domain name must be
specified if the user is a member of a domain (DOMAIN\Username).

8.2.3 Selecting a Backup Location

Select the appropriate backup location in the tree or specify the path to it manually in
the Path field below the tree.

You can also select specific Acronis backup locations (such as Acronis Backup Server).
The following resources may also be selected as backup locations:

o Entire disk or disk folder

e Network share, SAN, NAS

o FTP

e Tapes, Autoloaders, Tape Libraries

e Acronis Backup Server

The number of archives in the selected folder is displayed in the right pane.

Click Next to continue.

8.2.4 Selecting a Backup Task

If several backup tasks use the same location to store archives, you have to select the
task you want to restore from.

Note, Acronis Recovery for MS Exchange does not protect archives form
possible physical corruption. In case you try to restore data from the
corrupted archive, an error message will appear and the restore task will not
be executed. We recommend you to rename or delete the last archive’s slice
(since the corrupted one and all subsequent slices should be renamed or
deleted), and then try to execute the restore task once more.

Click Next to continue.
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8.2.5 Providing a Password

If there are any password-protected backup archives in the location you have selected
(see 9.1.3), you will need to enter the password to restore your data from archives.

Click Next to continue.

8.2.6 Restore Point Selection
Specify to which state you want to restore your data.

Acronis Recovery for MS Exchange offers four ways for restoring your data:

e to the point of failure — the data will be restored to the state at the point
of failure. To be able to restore to the point of failure, a chain of backed up
logs and also newly created log files (including an active log) must be
available in the selected location. Otherwise only restoring to the time of
the latest backup is available. Keep in mind, that restoring to the point of
failure can take a long time.

e to the time of the latest backup — choosing this option will restore your
data to the state when the last backup was created. So restoration to the
latest backup will be faster, than restoration to the point of failure.

e to a specific point in time - Acronis Recovery for MS Exchange allows
you to specify a date and time to restore your data from. Note, to be able
to restore to a specific point in time, Microsoft Exchange transaction logs
must be backed up. Data will be restored to the time of the last created
backup before the specified time, and then transaction logs will be applied.

o from the selected backup — select this option to choose a backup from
which to restore. A list of backups will be available by clicking on the Select
from the list of backups link. Choose the backup you want to restore
from and click OK.

After selecting the appropriate option click Next to continue.

8.2.7 Content Selection

Acronis Recovery for MS Exchange allows restoring mailboxes and separate public
folders. First, select a database server from the tree in the left pane.

Also Acronis Recovery for MS Exchange allows using a filter to display only the required
items in the tree. Type a word, which will help you to define the necessary folders, in
the Filter field.

Restoring Mailboxes

Choose a Storage Group and Mailbox Store from which you want to restore a mailbox.
Information (size and number of Mailboxes) about the selected items will be displayed
on the right.

In the drop-down list, specify the Mailbox (or separate folders) you want to restore.
Information about the size, number of folders and subfolder, as well as the total
number of e-mails will be displayed on the right.
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You can restore mailboxes to their original location or choose another mailbox
database as a new location. In the latter case the Next button will be disabled until
you choose a mailbox to restore to.

Restoring Public Folders

Choose a Storage Group, Public Folder Store and Public Folder from which you want to
restore a specific folder. Information about the selected items will be displayed on the
right.

In the drop-down list, specify the public folder you want to restore. Information about
size, number of folders and subfolders, as well as total number of e-mails will be
displayed on the right.

You can restore public folders to their original location or choose another folder as a
new location. In the latter case the Next button will be disabled until you choose a
public folder to restore to.

Click Next to continue.

8.2.8 Restore Options

Select the options for the restoration process (Pre/Post commands, restoration process
priority etc.). You can Use default options (See 9.2 “Setting Default Restore
Options” for more information.) or Set the options manually. If the latter is the
case, the settings will be applied only to the current restore task.

8.2.9 Selecting Start Parameters

You can run a restore task manually or specify the frequency (Daily, Weekly or
Monthly). See Chapter 9 “Scheduling Tasks” for detailed information.

8.2.10 Restore Summary

In the final step, the restoration summary is displayed. Up to this point, you can click
Back to make changes in the created task. If you click Cancel, no databases will be
restored.

Note, temporary files, created during the restore process, may require
considerable disk space. Hence, it is advisable to choose the appropriate
location for theses files.

While working with Acronis Recovery for MS Exchange Beta2 version, such a
location is selected automatically (current user's 7MP folder).

Click Finish to save the schedule or start the restore task immediately.
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8.3 Restoring Individual E-mails

In addition to restoring storage groups and mailboxes, Acronis Recovery for MS
Exchange can restore individual e-mails.

Start the e-mail restoration process by clicking on the restore operation icon in the
Tools group.

8.3.1 Selecting a Backup Location

To view available storage groups and mailboxes select the appropriate backup location
by clicking the Select location... link or specify the path to it manually in the Backup
location field.

You can also select specific Acronis backup locations (such as Acronis Backup Server).
The following resources may also be selected as backup locations:

e Entire disk or disk folder

e Network share, SAN, NAS

e FTP

e Tapes, Autoloaders, Tape Libraries

e Acronis Backup Server

8.3.2 Selecting a Backup Task and Point to Restore

If several backup tasks use the same location to store archives, you have to select the
task you want to restore from. Click the Select task... link to choose the backup task
and a point to restore e-mails to.

The left pane will display a list of available tasks. A selected task’s comments will be
displayed on the right.

Below you have to select to which state you want to restore e-mails.
Acronis Recovery for MS Exchange offers four ways for restoring your data:

e At the moment of failure — e-mails will be restored to the state at the
point of failure. Keep in mind, that restoring to the point of failure can take
a long time.

o At the time of the latest backup — choosing this option will restore your
e-mails to the state when the last backup was created. So restoration to the
latest backup will be faster, than restoration to the point of failure.

¢ On the following date - Acronis Recovery for MS Exchange allows you to
specify a date and time to restore your e-mails from.

o At the time of the following backup — select this option to choose a
backup from which to restore. A list of backups will be available by clicking
on the Select from the list of backups link. Choose the backup you want
to restore from and click OK.

After selecting the appropriate option click OK to return to the E-mail Restoration
window.
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8.3.3 Setting Additional Search Options

Filter

Acronis Recovery for MS Exchange allows using a filter to display only the required
items in the tree. Type a word, which will help you to define the necessary folders, in
the Filter field. Only Mailboxes containing this word will be displayed in the tree
below.

Text to search

You can enter a text you want to search for in e-mails’ subjects in a corresponding field
and click the Search button. As a result, only e-mails whose subject contains that text
will be displayed below.

Advanced search options

Click the Advanced search options link to specify additional options for e-malil
searching:

e Search by person — select this option to specify e-mail addresses of a
sender and/or recipient

e Search by date — select this option to specify the period of time (From and
To) to search for required e-mail

e Search in — select this option to specify the following parameters:

0 Message header — Acronis Recovery for MS Exchange will search for the
required text only in messages’ headers

0 Messages with attachments only — Acronis Recovery for MS Exchange
will search for the required text only in messages with attachments.

After setting the appropriate options click OK to return to the E-mail Restoration
window.

8.3.4 Selecting E-mail Exporting parameters

Select the way you want to export selected emails from the drop-down list before
starting the restoration process, and then click Restore:

e To original location — e-mails will be restored to their original location
(mailbox or public folder)

e Save to file — select the location where e-mails will be saved and choose a
type of the file (* ixt, *.oft, *.msg, * htm, *.mhi) and click OK

e Send by e-mail — restored e-mails will be sent to specified addresses.
Provide e-mail addresses and the outgoing SMTP server name. A Username
and a password may also be needed if the SMTP server requires
authentication and click OK.

8.4 Setting Default Restore Options

To view or edit the default restore options, select Tools -> Options -> Default
Restoration Options from the main program menu.

You can also edit restore options while creating a restore task.
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B8 Options

Options
‘fou can set backup options, Choose the category in the tree and set the options in the right pane. t,

@[ Server list options ‘. o _ _
&) Motifications . a Default restoration options
] B Default backup options

Option that will be used for restore by default,

= 3 Default restoration options
K5 PrefPost commands
B Restore priority
@ Additional settings

)

8.4.1 Pre/Post Commands

You can specify commands or batch files to be automatically executed before and after
the restore procedure. Click Edit to open the Edit Command window and input the
command, its arguments and the working directory, or browse folders to find a batch
file. Interactive commands (commands that require user input) are not supported).

E§ Options

Options

‘ou can set backup options. Choose the category in the tree and set the options in the right pane.

53] l'_ﬁ Server list options o
54 Motifications Eé Pre/Post commands

=] & Default backup options
= a Default restoration options

o
by Restore priority
@ Additional settings @ UUse commands set: by default

Specify commands that will be executed before and after the restore process. Enter
wour command manually or click Edit to configure the command.

O Use the following commands:
Befare restore process:
After restare process:

| NN=E

)

8.4.2 Restoration Priority
You can set up the restore process priority:

e Low - the restore process will run slower, but it will not influence other
processes running on your computer

o Normal - set by default. The restore process will run with normal priority

e High - the restore process will run faster, but it may influence other
processes running on your computer
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Changing the restore process priority may have an adverse effect on the performance
of other programs running simultaneously. The priority of any process running in the
system determines the amount of CPU usage and system resources allocated to that
process.

o ptions @

DOptions
‘ou can set backup options, Choose the category in the tree and set the options in the right pane.

.’ﬂLgﬂ Server list options | e
[#H5 Matifications B Gestole pionty
fﬂ@ Defaulk backup options
E‘a Defaulk restoration options
@ FrefPost cammands
Restore priority O Low
@ Additional

*fou can set up the priority of the restore process making it run faster or slower,
ioity
settings (3\ Nara
() High

Description
Backup process will be running with normal priority,

9

8.4.3 Additional Settings

Backup archive validation

Before data is restored from the archive, Acronis Recovery for MS Exchange can check
its integrity. If you suspect that the archive might have been corrupted, select
Validate backup archive before restoration.

Overwriting mode

Enable Overwrite existing e-mails parameter to make Acronis Recovery for MS
Exchange overwrite existing e-mails with restored ones.

8.5 Acronis Active Restore or Dial Tone Recovery?

Acronis Recovery for MS Exchange allows a faster databases recovery using two
methods — Acronis Active Restore and dial tone mode. This section describes
differences and advantages of each method.

Using Acronis Active Restore

Acronis Active Restore acts the following way: after starting s restore task, a backed up
database is mounted directly from the archive. Then transaction logs, which are being
taken from the archive, will be applied. It is important, that database becomes
available for users after a short time — users can work with their folders, calendars, e-
mails. All other data is being restored from the archive in the background. After the
restore operation is completed, the database will be remounted, which takes less, than
a minute.

Please note, using Acronis Active Restore is inefficient if archives are located
on tapes or ftp servers — this operation may be time consuming.
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Using Dial Tone Recovery

Restoring a huge Microsoft Exchange Server database may take several hours before
users can start working with it again after a disaster. But Acronis Recovery for MS
Exchange makes it possible to use a dial tone to recover e-mail service in the first
place, and only then restore users’ data as it becomes available (only in Microsoft
Exchange Server 2007).

Main advantages of using dial tone mode are independence from the log's size and
almost instant access to the e-mail service.

At first, a temporary empty dial tone database will be created. Microsoft Exchange
Server will create new mailboxes (with the same GUID values as the old ones) in this
database, so that users can start sending and receiving e-mails, but other data (such
as contact lists, rules, stored e-mails, etc.) still will not be available. This process takes
only two minutes or even less. After restoring the database to the selected location
and applying logs, all recovered data will be merged with new e-mails (which were
sent or received during the dial tone recovery) bringing mailboxes to the up-to-date
state, which takes the database off-line for several minutes. On operation completion,
temporary dial tone databases will be deleted.

Note, public folders can not be restored using dial tone mode, i.e while
restoring storage groups, which contain mailboxes and public folders, only
mailboxes will be restored. We recommend you to restore public folders
separately, not using dial tone mode.

Comparing Acronis Active Restore and Dial Tone Recovery

Acronis Active Dial Tone
Restore Recovery
MS Exchange accessibility while -
. yes limited
restoring
Public folders restoring yes no

only MS Exchange

Supported MS Exchange editions all editions 2007

Logs size affection yes no
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Chapter 9. Scheduling Tasks

9.1 What is a task?

A task is a job you execute for a database that includes the type of operation (backup,
restore, etc.), parameters of the operation (what to backup, what to restore, etc.) and
a schedule (optional). Each time you want to perform an operation with specific
parameters, you should create a task. Once the task is created, you can execute it
manually at any time or run it on a scheduled basis (if provided). You can also
schedule independent or redundant tasks for the same information store or storage

group.

9.2 Setting Schedule Parameters

You can run a task manually or specify the frequency (Daily, Weekly or Monthly).

Manually — this option allows you to create a task without specifying the exact
schedule of its execution. The created task appears in the task management list and
may be run at any time.

B8 Task Schedule

Schedule

‘fou can schedule creation of the database backups.

Frequency This option allows you to create a task without specifying the exact time and periodicity
of its execution. The created task appears in the task management list and you will be
Manually able to manually run the task execution at any time that is the most corvenient For you,
Daily
Weekly
Monthly
One time
| Result: Start manually |
9
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Daily - the task will be executed daily at the specified time. You can set the following

parameters:

Parameter Description

Recur every (...) | The task execution frequency

days

Start time Time for starting the task. The current time is set by default

Repeat Task execution frequency: Once for a single execution and
Every (...) for periodic executions throughout the day (in
minutes or hours)

End time Time when the schedule will be disabled

Start date Select this check box to specify the date to enable this schedule

End date Select this check box to specify the date when this schedule will

be disabled

B8 Task Schedule

Schedule

‘ou can schedule creation of the database backups.

Frequency

|
Manually
|

Weekly

Monthly

One time

T
Reecur every: | 5 davy(s)

Skart kime: |08:13:06 PM ;I

Repeat:

(@) orce
ti:) Ewvery

End time:
[] End date:

1z hour(s)

[i1 0P |

23] uR][ 207

22 i1 2007

Result: Start the task every 1 day(s) at 8:13:06 PM, Repeat once, Effective from 11j22/2007, |

9

Weekly - the task will be executed on a weekly basis at the specified time and days.
You can set the following parameters:

Parameter Description

Recur every (..)| The task execution frequency. Select individual days of the

weeks week, all days or only workdays.

Start time Time for starting the task. The current time is set by default

Repeat Task execution frequency: Once for a single execution and
Every (...) for periodic executions during the day (in hours)

End time Time when the schedule will be disabled

Start date Select this check box to specify the date to enable this schedule
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End date

Select this check box to specify the date when this schedule will
be disabled

B8 Task Schedule

Schedule

‘ou can schy

Frequency

| Recur every: 1 “' weekis) on: [ =al days= [] «workdaysz
Manually I
Daily [Jsunday [IMonday []Tuesday  [] wednesday

. weekly [ thursday [ Friday ] Saturday

| Monthly

One time

ation of the database backups.

Starttime:  |08:13:06 PM 3|
Repeat:

(E) Once

(:) Ewery 12 | |hour(s)

Endtime:  [11.53:59 P |
starcdetes | 22 5[ 11 2| 000 %]
[JEnddate: | 22 {| 11 || 2007 |

Result: Start the task every 1 weekis)on at 8:13:06 PM, Repeat once, Effective from 11/22/2007.

?)

Monthly - the task will be executed monthly at the specified time and day. You can
set the following parameters:

Parameter

Description

Months

Select months for the task execution from the drop-down list.
Then choose one of the following parameters:

Days - choose this parameter to specify days of the selected
months for task execution. Choose the dates from the drop-
down list. Also you can select Last (to execute the task on the
last day of the chosen months) or All days. For example, if you
have selected “15” and “Last”, the task will be executed on
every 15th and every last day of the selected months.

On - choose this parameter to select a week number of the
month (also Last or All) and the day of the week (as well as
All days and All Workdays) for task execution. For example,
if you have selected “First” and “Monday”, the task will be
executed on the first Monday of the selected months.

Start time

Time for starting the task. The current time is set by default

Repeat

Task execution frequency: Once for a single execution and
Every (...) for periodic executions during the day (in hours)

End time

Time when this schedule will be disabled

Start date

Select this check box to specify the date to enable this schedule

End date

Select this check box to specify the date when this schedule will
be disabled
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¥ Task Schedule

Schedule

‘ou can schedule creation of the database backups.

Frequency

Months: |4l manths ~|
I:;T:a“y @)Dayst [1,3,5,7,9 11,13, 15, 17, 19, 21, 23, 28+
Weelly Con | Il |
Starttme: [08:13:06 PM 3]
One time Repeat:

@) Once

Oevery | 12 [houts)

Endtime: |11 59159 FM

start dete: | 22 3|[ 1 3][ zoo7 %]

[JEnd date: 22 11 24|

Result: Startthetaskatl, 3,5, 7,9, 11, 13, 15, 17, 19, 21, 23, 25, 27, 29, Last of All months at §:13:06 PM,
Repeat once, Effective from 11222007,

@

One time - the task will be executed once at the specified time and day. You can set
the Start time parameter: specify the date and time to start the operation. Current
time is set by default.

¥ Task Schedule

Schedule

‘fou can schedule creation of the database backups,

Frequency

starttine: | 22 %[ 11 3][ 2007 %] [op:13:08 P &
Manually
Daily
wWeekly
Monthly
onetime____|

| Result: Start the task on 11/22(2007 at §:13:06 PM |

)

All the settings you made are displayed in the Result field at the bottom of the
window.

To save your settings, click OK.
To quit task scheduling without saving, click Cancel.

Note, Acronis Recovery for MS Exchange allows you to set multiple schedules for one
task. For example, you can backup your data not only once a week, but also on the
last day of each month. You can specify Weekly and Monthly parameters to have the
necessary operation schedule.
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Chapter 10. Managing Tasks

To manage operations, click Manage Tasks in the Pick a Tool group or select the
Tools -> Manage tasks menu item.

All the scheduled tasks appear in the Scheduled Tasks pane in the Manage Computer
Tasks window of the Acronis Recovery for MS Exchange Management Console.
Information about the task name, credentials, the type of backup, its status
(completed, scheduled), the task’s schedule and the date and time when it was run
last is displayed.

You can edit, start, and delete the scheduled tasks from these windows, as well as edit
the scheduled set of tasks.

Note, backup tasks may consist of two subtasks: full and incremental backups.
You can manage these subtasks separately.

10.1 Editing a Task

To edit a task, select it in the Tasks window and click Edit Task on the left. Follow the
wizard'’s instructions on the screen.

10.2 Deleting a Task

To delete an existing task, select it in the Tasks window and click Delete Task on the
left. Follow the wizard’s instructions on the screen.

10.3 Starting a Task

To begin executing an existing task immediately, select it in the Tasks window and
click Start Task Now on the left.

10.4 Viewing a Disaster Recovery Plan

Click the View Disaster Recovery Plan link in the tasks pane. The plan is provided
in HTML format. See details in Chapter 6 “Disaster Recovery Plan”.
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Chapter 11. Notifications

Acronis Recovery for MS Exchange can notify you when a task is complete using an
SNMP service or via e-mail.

By default all notifications are disabled.

11.1 E-mail Notifications

Specify a singular default e-mail account that will be used for notifications regarding
the backup operation process. Provide the e-mail address to which notifications will be
sent and the outgoing SMTP server name. A username and a password may also be
needed if the SMTP server requires authentication.

You can choose when you want to receive notifications:
e after successful completion of the operation
» if the operation fails

You can also add full log to notification selecting the corresponding parameter.

FE o ptions

Dptions

‘fou can set backup options, Choose the category in the tree and set the options in the right pane.

E.,'_d Server lisk options ¥ 3 i
=) Motifications E I
=9 E-mail
Sy Specify the e-mail account that will be used For notifications about completion of
; backup operation, You can specify several e-mail addresses separating them by a
L-=,| ‘Windows event log Gt

mg Default backup options
F_l& Default restoration options

E-mail address: |admin@compary. com |

Outgoing mail server (SMTP): | sk, companty . com ‘

Set pork: [ 25 cj
User name: |admin |
Password: |osessese

Send notification upon operation's successful completion:

[[] Send notification upon operation Faiure

Additional e-mail parameters. .

Send Test E-mail Message

)

Click the Additional e-mail parameters... link to specify the From and Subject
fields for the notification e-mail.
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You can check if the settings are correct by clicking the Send Test E-mail Message
button.

11.2 SNMP

You can choose whether to send event log messages issued by Acronis Recovery for
MS Exchange to computers running SNMP (Simple Network Management Protocol)
management applications.

To specify SNMP settings, check the Send Notification with SNMP parameter to enable
SNMP notification.

In the Community Name field, enter the name of the SNMP community to which
both the Host (the computer running the SNMP management application) and the
computer running the task belong.

In the Host Name field, enter the name of the computer running the SNMP
management application, to which notifications will be sent. If not specified, messages
will be sent to all SNMP clients found in the local network.

Below in this window you can choose whether you want to get notifications:
e upon the operation's successful completion parameter

e upon the operation failure parameter

You can check if the settings are correct by clicking the Send test SNMP message
button.

11.3 Windows event log

You can save event messages to the Windows Event Log (to see this log, run
eventvwr.exe or select Control Panel -> Administrative tools -> Event Viewer).

To save event messages to Windows Event Log select the Save messages option and
choose one of the following from the drop-down list:

« All events - all events (information, warnings and error messages) will be
recorded to the Windows Event Log

e Warnings and errors - warnings and error messages will be recorded to
the Windows Event Log

e Errors only - only error messages will be recorded to the Windows Event
Log
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Chapter 12. Viewing Logs

Acronis Recovery for MS Exchange working logs. The logs provide information about
scheduled task results, including failure reasons, if any. To view logs, click the Logs
item in the Pick a Tool group.

The log browsing window contains two panels: the left panel features the log list, and
the right panel displays the selected log’'s contents. You can set up list parameters to
only display messages of a particular type, display particular columns, or select a
sorting order.

To the left, there are 3 message filter options:
o filter error messages
o filter warnings
o filter information messages
To select columns to display, click the button and check columns to display.

To sort messages by a particular column, click its header (click again to reverse the
order) or the button (the second from the right) and select the desired column.

You can also change column width by dragging its borders with the mouse.
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Chapter 13. Command-line Mode

Acronis Recovery for MS Exchange supports the command-line mode. The command-
line user interface provides the ability to execute most of Acronis Recovery for MS
Exchange functionality. There are four operations you can run in command-line mode:

e List — obtain a list of archive locations, archives’' ID, credentials and other
information

e Info — obtain information about required items, such as a name of a storage
group, number of its databases, their total size, etc

e Backup - back up required items, as well as specify backup options
e Restore — restore required items, as well as specify restore options

Commands may be accompanied with options.

It is important to keep the prescribed order of specifying parameters.

Note, parameters should be entered in double quotes in case they contain
non-Latin symbols (see usage examples).

To view all available commands and their options, execute the following command
Cmd.exe [/h] [/?] in command line prompt.

Below are sections describing each command and their options with corresponding
usage examples.

13.1 List Command

cmd.exe list [/location:<URI> [/credentials. "<login>:<password=>"]]
[7archive:<name= [/password:<password=>]] [/item:"<item>"] [/pit:<time>]

13.1.1 Description of Options

/location:<URI>
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Lists an archive location’s URI. The path may be specified in one of the
following ways: “C:\path\to\dir\”, “\\computer\share\dir\”,
“ftp://host/mybackups/” or “bsp://host/BackupServer”.

/credentials:<login>:<password=>

Displays task execution account’s credentials
/archive:<name=>

Lists an ID of an archive within the specified location
/password:<password=>

Displays a password for the required archive location
/item:<item>

Lists a parent item in the following format:

“//StorageGroup _name/Mailbox_name/Folder_name’. 1t can be null for storage
groups

/pit:<date><time>

Displays items in a specific point in time. The time format depends on a system
locale of the particular computer (i.e. “01.06.2008 12:07:55”). The value can
also be <latest> that means the latest backup, and <pof> - point of failure

13.1.2 Usage Examples

o cmd.exe list /item.: //StorageGroupl”
This command will list all mailboxes of storage group 1
o cmd.exe list /location. "bsp.//host/BackupServer” /archive.:archivel /pit:latest

This command will list all storage groups in archivel located in
bsp://host/BackupServer

13.2 Info Options

Cmd.exe info [/location:<URI> [/credentials: "<login>:<password>"]]
[/archive:<name= [/password:<password=]] /item:" "<jtem>" [/pit:<time>]

13.2.1 Descriptions of Options
/location:<URI>

Displays an archive location’s URI. The path may be specified in one of the
following ways: “C:\path\to\dir\”, “\\computer\share\dir\”,
“ftp://host/mybackups/” or “bsp://host/BackupServer”.

/credentials:<login>:<password=>

Task execution account’s credentials
/archive:<name=>

Displays an ID of an archive within the specified location
/password:<password=>

Displays a password for the required archive location

/item:<item>
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Displays parent item information
/pit:<date><time=>

Displays items in a specific point in time. The time format depends on a system
locale of the particular computer (i.e. “01.06.2008 12:07:55”). The value can
also be <latest> that means the latest possible state, and <pof> - point of
failure

13.2.2 Usage examples

e Cmd.exe info /location:"bsp.//host/BackupServer”
[/credentials: admin.qwerty”] /archive:<archivel> [/password:<password>]

This command will display information about archivel located in
bsp.//host/BackupServer, credentials used are admin (login) and qwerty
(password)

13.3 Backup Options

cmd.exe backup /location:<URI> [/credentials: "<login>:<password>"]
/archive:<name> [/item. "<jtem=>"] [/backupType:FulllIncremental]
[/compression:None[Normal[High/Maximum/Ultimate] [/encryption: "None[AES
128[AES 192[AES 256:<password="] [/substitute]

[/throttle:<throttle>] [/validate]

[priority:Low[NormallHigh] [/forceBrick]

13.3.1 Description of Options

/location:<URI>

Displays an archive location’s URI. The path may be specified in one of the
following ways: “C:\path\to\dir\", “\\computer\share\dir\”,
“ftp://host/mybackups/” or “bsp://host/BackupServer”.

/credentials:<login>:<password>
Task execution account’s credentials
/archive:<name>
Displays an ID of an archive within the specified location
/item:<item>
This parameter is optional and displays a parent item in the following format:
“//StorageGroup_name/Mailbox_name/Folder_name’

To back up all storage groups set “//” as the parameter's value. If this
parameter is not specified, the whole information store will be backed up

/compression:<None | Normal | High | Maximum | Ultimate>
Specifies archive compression level. Normal is set by default
/backupType:<Full] Incremental>
Specifies a type of backup to be created.
/encryption
/encription:<”AES 128 AES 192 | AES 256>
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Specifies the encryption method of the created archive
/password:<password=>
Displays a password for the required archive location
/substitute
Specifies substitution
/throttle
Specifies throttle bandwidth in kb/s (the value can be from 0 to 100000 kb/s)
/validate
Specify this parameter to validate the created backup archive
/priority:<Low | Normal | High>
Specifies priority of the backup operation
/forceBrick

Use this parameter to force brick level backup method. For storage groups’
items operation uses database level, for mailboxes/folders — brick level

13.3.2 Usage Examples

o Cmd.exe backup /location”:bsp.//host/BackupServer”  /archive:archivel
Jitem.”//MyStorageGroup/MyAccount” /credentials: ”admin.qwerty”

This command will back up MyStorageGroup/MyAccount to the
bsp.//host/BackupServer folder, the created archive will be called
archivel, credentials will be used: admin (login) and qwerty (password)

13.4 Restore Options

cmd.exe restore /location:<URI> [/credentials: "<login>:<password>"]
/archive:<name= [/password:<password=>] [ /item:"<item>"
[/storagegroup:<storagegroupname=Jf/activerestore] [/dialtone
[/overwriteDialtoneDB]]] [/pit:<time=] [/priority:Low[Normal[High] [/validate]
[/overwriteExistingEmails]

13.4.1 Description of Options

/location:<URI>

Displays an archive location’s URI. The path may be specified in one of the
following ways: “C:\path\to\dir\", “\\computer\share\dir\”,
“ftp://host/mybackups/” or “bsp://host/BackupServer”.

/credentials:<login>:<password=>

Task execution account’s credentials
/archive:<name=>

Displays an ID of an archive within the specified location
/password:<password=>

Displays a password for the required archive location
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/item:<item>
This is an optional parameter. It specifies a parent item in the following format:
“//StorageGroup _name/Mailbox_name/Folder _name’

To restore all storage groups set “//” as the parameter’s value. If this
parameter is not specified, the whole information store will restored

/activerestore

Specify this parameter to use Active Restore mode (for restoring storage
groups only)

/dialtone

Specify this parameter to use dial tone mode (for restoring storage
groups only)

/storagegroup

Specifies a storage group to restore. Note, this option is incompatible
with /dialtone command

/pit:<date><time=>

Specifies a point in time to which to restore the required item. The time format
depends on a system locale of the particular computer (i.e. “01.06.2008
12:07:55"). The value can also be <pof> that means the point of failure.

/validate

Specify this parameter to validate the backup archive before restoring
/priority:<Low|Normal |High>

Specifies priority of the restore operation
/overwriteExistingEmails

Forces overwriting existing e-mails

13.4.2 Usage Examples

e Cmd.exe restore /location: bsp.//host/BackupServer”  /archive:archivel
/item.”//MyStorGroupl” /itemLogon.:admin:qwerty /item:MyStorGroupZ2

This command will restore MyStorGroupl and MyStorGroupZ from the
archive called archivel, located in bsp.//host/BackupServer
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Appendix A. Acronis Recovery for MS
Exchange: Best Practices

This section provides instructions for best practices when using Acronis Recovery for
MS Exchange.

A.l Protect your server from hardware failure, user errors
and viruses

Scenario

The company is running several internet and intranet applications on several Windows
2000 servers using Microsoft Exchange as the back end (using different information
stores). Since all transactions are stored in the database, any data loss is not
acceptable. The database administrator must provide protection from hardware failure,
user errors and virus attacks.

Acronis solution

Use the following components
= Acronis Recovery for MS Exchange Agent (on all servers with databases)
= Acronis Recovery for MS Exchange Management Console (on an administrator
workstation, from which you plan to manage tasks)

To schedule periodic backup

1. Install Acronis Recovery for MS Exchange Management Console on the
database administrator workstation and Acronis Recovery for MS Exchange
Agents on the server where Microsoft Exchange information stores are located

For every Microsoft Exchange instance perform the following actions:

2. Connect to the server from the Acronis Recovery for MS Exchange Management
Console using the appropriate credentials

3. Launch the Create Backup wizard and follow the instructions to create a
backup task:

a. Select the whole Microsoft Exchange instance (or all available instances)
as a backup source

b. Select a backup destination
c. Select Full and Incremental backups type

d. Schedule full backups for every month, incremental backups for every
week
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e. Use default settings for backup
f. Add the necessary comments for the task

g. Save the created task

To recover all data in case of hardware failure
For every damaged server perform the following actions:

1.

Install and configure a new server. Install the necessary Microsoft Exchange
information stores on the server.

Install Acronis Recovery for MS Exchange Agent on the server

Connect to the server from Acronis Recovery for MS Exchange Management
Console using the appropriate credentials

Launch the Restore Data wizard and follow the instructions to restore the
database:

a. Select the backup archive location
b. Select the Restore to point of failure option

c. Select the whole Microsoft Exchange information store (or several
storage groups) to restore from, then specify the target storage group
for each storage group.

d. Start the restore operation

All Microsoft Exchange storage groups will be restored to the point of failure
to avoid data loss.

To recover all data in case of a user mistake
For all servers perform the following actions:

1.

Connect to the server from Acronis Recovery for MS Exchange Management
Console using the appropriate credentials

Launch the Restore Data wizard and follow instructions to restore the
database:

a. Select the backup archive location

b. Select the Restore to point in time option and specify the date and
time manually, or select the backup from the list of backups.

c. Select the database to restore from the archive

d. Start the restore operation
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Only one database will be restored to the selected point in time.

To recover all data in case of a virus attack
For all servers perform the following actions:

1. Recover the server from viruses, reinstall the operating system or replace the
server with a new one.

2. Connect to the server from Acronis Recovery for MS Exchange Management
Console using the appropriate credentials

3. Launch the Restore Data wizard and follow the instructions to restore the
database:

a. Select a backup archive location

b. Select the Restore to a point in time option and specify the date and
time manually or select the required backup from the list of backups.

c. Select the whole Microsoft Exchange information store (or several
storage groups) to restore, and specify the target location for each
information store.

d. Start the restore operation

All Microsoft Exchange information stores will be restored to a point in time.

A.2 Protect your server to guarantee minimal data loss

Scenario

The database administrator must organize the server backup creation so that in case of
a server failure for any reason, the maximum data loss would not be more than 15
minutes.

Acronis solution

Connect to Acronis Recovery for MS Exchange Management Console and create a
backup task for Microsoft Exchange with the following backup strategy: Full Backup
(every week) + Incremental backup (every day).

To recover all data in case of failure, use the same procedure as described in the
previous scenario (A.1).
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A.3 Backing up several databases

Scenario

The company uses only one Microsoft Exchange instance for running several
databases. All databases have different levels of importance concerning data loss:
some of them need to be backed up every day, others require only weekly backups.

Acronis solution

The database administrator should create independent tasks for different databases.
While creating a task, the database administrator specifies the appropriate schedule for
each database.

A.4 Encrypting database archives for storage

Scenario

The company stores database backup archives off-site, hence they should be
effectively protected (encrypted).

Acronis solution

While creating a backup task, the database administrator should set a password to
protect the archive and encryption type (AES 128, 192 or 256) by specifying backup
options.

While creating the restore task, the administrator has to provide the correct password
to the archive in order to restore the data. The password should be kept in a safe
place so that data may be restored if the company hires new administrators.

A.5 Using the Disaster Recovery Plan to restore databases

Scenario

The business owner wants to be sure that the databases can be restored at any time,
even in case the database administrator is not available for any reason. For that
purpose, a comprehensive Disaster Recovery Plan should be created, which will help a
person without DBA knowledge restore damaged databases.

Acronis solution

While creating a backup task, the database administrator should specify a Disaster
Recovery Plan option, so that it would be sent to the business owner’s email. In case
of a disaster, the staff can restore databases according to the instructions contained in
the Disaster Recovery Plan.

A.6 Manual backup (before crucial changes in databases)
Scenario

The company is preparing to make extensive changes to the databases. To avoid
possible loss, the databases must be backed up.
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Acronis solution

The database administrator can use previously created backup tasks and start them
manually from the Acronis Recovery for MS Exchange Management Console.

Another option is to start a new task for creating full backups. The administrator can
specify it so that it will only be executed manually.
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Appendix B. Installing Acronis
Recovery for MS Exchange from
command line

Acronis Recovery for MS Exchange supports the Microsoft Installer utility (msiexec.exe)
with all its commands. Here is the MSI installation command and options:

Install Options
/1 <Component.msi | ProductCode>

Installs or configures a product. ProductCode is the serial number of your
personal copy of Acronis Recovery for MS Exchange Agent

COMPONENT=[component]
Specifies the component you want to install:
AcronisRecoveryMsExchangeAgent - Acronis Recovery for MS Exchange Agent

AcronisRecoveryMsExchangeConsole - Acronis Recovery for MS Exchange
Management Console

USERNAME=[username] PASSWORD=[password]

Specifies username and password for running Acronis Recovery for MS
Exchange Agent installation

/e[path]

Specifies a path to extract an .msi file to.
/a <Component.msi | ProductCode>

Applies the administrative installation option
/x <Component.msi | ProductCode>
Uninstalls the product

Example

msiexec /i C:\ AcronisRecoveryMsExchangeAgent.msi

Installs Acronis Recovery for MS Exchange Agent.
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Reinstall Options
/f[ploleld|clajJu]lm]|s]v] <Component.msi | ProductCode>

Reinstalls or upgrades the product

p — reinstalls only missing files

0 — reinstalls the file if it is missing or it is an older version

e - reinstalls the file if it is missing or is the same or an older version

d - reinstalls the file if it is missing or a different version is present

¢ — verifies the checksum values, and reinstalls the file if it is missing or corrupt
a — reinstalls all files

u — rewrites all required registry entries from the Registry Table that go to the
HKEY CURRENT USER or HKEY USERS registry hive

m — rewrites all required registry entries from the Registry Table that go to the
HKEY LOCAL MACHINE or HKEY CLASSES ROOT registry hive

s — reinstalls all shortcuts and re-caches all icons overwriting any existing
shortcuts and icons

v - used to run from the source package and re-cache the local package.

This option ignores any property values you specify at the command line. The
default value for this option is /foecms.

Example
msiexec /fpecms C:\ AcronisRecoveryMsExchangeAgent.msi

Reinstalls Acronis Recovery for MS Exchange Agent.

Advertising Options
/ifulm]
Advertises a component with the following options:
u — only for the current user
m — for all users of the computer
/g LanguagelD - identifies the language
/t TransformList — applies transform to advertised component

This option ignores any property values you specify at the command line. To install the
component with elevated privileges, use /jm.

Example
msiexec /jm C:\ AcronisRecoveryMsExchangeAgent.msi

Advertises Acronis Recovery for MS Exchange Agent for all users of the computer.

Logging Level Options
msiexec /L [i][w][e]l[a]llr][ul[c]l[m][p]lVI[+][']LogFile.txt
/L - Specifies the path to the log file

i - Logs status messages
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w - Logs nonfatal warnings

e - Logs all error messages

a - Logs startup of actions

r - Logs action-specific records

u - Logs user requests

¢ - Logs initial user interface parameters

m - Logs out-of-memory

p - Logs terminal properties

v - Logs verbose output. To use v, specify /L*v
+ - Appends to existing file

I - Flushes each line to the log

* - Logs all information except for the v option. This is a wildcard
LogFile.txt - Name and path of the text log file

To include the v option into a log file using the wildcard flag, specify /L*v at the
command line.

Example
msiexec /i C:\ AcronisRecoveryMsExchangeAgent.msi /Lime logs.txt
Installs Acronis Recovery for MS Exchange Agent and creates log file /ogs.itxt
containing information about the status, out-of-memory and error messages.
Applying a Patch Options

/p PatchPackage

/p - Applies a patch

PatchPackage - Specific patch

Example
msiexec /p PatchPackage /a C:\ AcronisRecoveryMsExchangeAgent.msi

Applies a patch to an administrative installation component.

Options for Installing a Transform
msiexec /i component TRANSFORMS= TransformList

TRANSFORMS= - Property that is used to specify what transform (./ms? files
should be applied to the component

TransformlList - List of paths separated by semicolons
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Options for Advertising Using a Transform
msiexec Zj[u][m] component /t TransformList

User Interface Level Options
msiexec Zg{n]b]r]f|n+]b+]b-}

/qn - Displays no user interface
/qb - Displays a basic user interface

/qr - Displays a reduced user interface with a modal dialog box displayed at
the end of the installation

/qf - Displays the full user interface with a modal dialog box displayed at the
end

/qn+ - Displays no user interface, except for a modal dialog box displayed at
the end

/qb+ - Displays a basic user interface with a modal dialog box displayed at the
end

/qb- - Displays a basic user interface with no modal dialog boxes

Note, /gb+- is not a supported user interface level. The modal box is not displayed if
the user cancels the installation.

Example
msiexec /gb AcronisRecoveryMsExchangeAgent.msi

Displays the basic user interface options during the Acronis Recovery for MS Exchange
Agent installation.

Copyright Information Displaying Options
msiexec {/?|/h}

Displays the Windows Installer version and copyright information.

Calling the system API DIIRegisterServer Option
msiexec /y |z module

/y - Calls the system API DIIRegisterServer to self-register modules passed on

the command line

/z - Calls the system API DllUnRegisterServer to unregister modules passed on

the command line
module - Specifies the file name of the module

These options are only used for registry information that cannot be added using the
registry tables of the .msrfile.
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